# Contents

## PART 1  Installation  1

### Chapter 1 • System and Software Configuration 3
- Supported System Configurations 3
- Third-Party Software 4
- Client Requirements 9
- Pre-installation Checklist 9
- Port Communication 10

### Chapter 2 • Pre-installation Tasks 13
- Set Up Roles and Features on Windows 2012 13
- Set Up Roles and Features on Windows 2008 14
- Installing Third-Party Software 15
- For SAS Marketing Operations Management Desktop 18
- Configuring the SQL Server 18
- Verify IIS Settings 20
- Start ASP.Net State Service 20

### Chapter 3 • Installing SAS Marketing Operations Management 21
- Installing SAS Marketing Operations Management 21

## PART 2  Post-installation  27

### Chapter 4 • Post-installation Tasks 29
- Overview 29
- Confirm Installation of Windows Services 29
- Microsoft Office Processor Machine Settings 32
- Configuring Security Permissions 32
- Configure Settings for a Digital Library That Supports a Shared Network Folder 33

### Chapter 5 • Tenant-Related Configuration Tasks 35
- Configuring the Tenant 35
- Configuring Additional Settings for the Tenant 38

### Chapter 6 • Additional Configuration Tasks 45
- Changing the MOMUSR Password 46
- Configuring the Media Server Proxy 47
- Configuring the Replication Agent 48
- Fine-Tuning Tips 51
- Tuning the Database 54
- IIS Performance Tuning 55
- Configure SAS Marketing Operations Management for Full Text Searching 56
- Suppress Dialog Boxes for Automatic Updates 56
- SAS Marketing Operations Management Diagnostic Utility 57
- Configure SAS Marketing Operations Management Cleanup Utility 59
- SAS Marketing Operations Management Service Monitor Configuration 61
<table>
<thead>
<tr>
<th>Chapter 7 • Uninstalling SAS Marketing Operations Management</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uninstall SAS Marketing Operations Management</td>
<td>63</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PART 3  Troubleshooting</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 8 • Troubleshooting</td>
<td>67</td>
</tr>
<tr>
<td>User Creation Fails—Configure Windows User on the Server</td>
<td>68</td>
</tr>
<tr>
<td>Orphan Files Created under File Mount Point</td>
<td>68</td>
</tr>
<tr>
<td>Configure Environment Variables-Failed</td>
<td>69</td>
</tr>
<tr>
<td>Virtual Folder aspnet_client Creation Failed</td>
<td>70</td>
</tr>
<tr>
<td>No Security Permissions Exist</td>
<td>70</td>
</tr>
<tr>
<td>Adding a DLL in the Global Assembly Cache</td>
<td>71</td>
</tr>
<tr>
<td>Running a Service under the MOMUSR Context</td>
<td>72</td>
</tr>
<tr>
<td>Setting the Event Log</td>
<td>73</td>
</tr>
<tr>
<td>Create Shared Drive</td>
<td>74</td>
</tr>
<tr>
<td>Database Creation Fails</td>
<td>74</td>
</tr>
<tr>
<td>Create an ODS Database for the Tenant</td>
<td>76</td>
</tr>
<tr>
<td>Creating Queues Manually</td>
<td>77</td>
</tr>
<tr>
<td>Deleting a Tenant</td>
<td>78</td>
</tr>
<tr>
<td>Configure a Virtual Directory for the Tenant</td>
<td>86</td>
</tr>
<tr>
<td>Creating the Desktop Folder</td>
<td>88</td>
</tr>
<tr>
<td>Working with Application Pools in IIS Manager</td>
<td>88</td>
</tr>
<tr>
<td>Verify Complete Access for MOMUSR</td>
<td>91</td>
</tr>
<tr>
<td>Configuring Scheduled Tasks</td>
<td>91</td>
</tr>
<tr>
<td>Destroy Session with DELETE Method Not Working</td>
<td>93</td>
</tr>
<tr>
<td>Checking Logs for Errors</td>
<td>93</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>95</td>
</tr>
</tbody>
</table>
Part 1

Installation

Chapter 1
System and Software Configuration .................................. 3

Chapter 2
Pre-installation Tasks ...................................................... 13

Chapter 3
Installing SAS Marketing Operations Management ................. 21
Chapter 1
System and Software Configuration

Supported System Configurations

SAS Marketing Operations Management is supported on the following system configurations, which can consist of one to four servers.

In a given configuration, you need to select one or more components while you are installing SAS Marketing Operations Management on an individual server in the configuration. The installer components that you select depend on the tiers that the server will host.

The installation consists of the following five tiers:

- application tier
- web server tier
- cataloger tier
- media processor tier
- database tier

The installer has components that relate to the first four tiers. You do not need to run the installer for the database tier.
This document applies to the following system configurations that consist of the following servers:

**Solutions Server**
- Hosts the web server tier.

**Web Services Server**
- Hosts the application tier.

**Cataloger Server**
- Hosts the cataloger tier.

**Media Processor**
- Hosts the media processor tier.

**Database Server**
- Hosts the database tier.

---

**Third-Party Software**

Install the following third-party software on the specified servers before you install SAS Marketing Operations Management 6.6. Contact SAS Technical Support for the location of the installers for the following software. The names of the installer packages are mentioned in the following table:

*Note:* If your order information for SAS Marketing Operations Management 6.6 specifies an internal reference number of 17w25 or prior (for example, Rev. IND_16w44), then you must deploy .NET Framework 4.6 manually on Windows Server 2008 R2 SP1 or Windows 2012 R2 before installing SAS Marketing Operations Management. Beginning with revision IND_16w48, the SAS Deployment Wizard deploys .NET Framework 4.6 for SAS Marketing Operations Management 6.6. A manual deployment for .NET Framework 4.6 is not required for SAS Marketing Operations Management 6.6 in 16w48 and later.

**Table 1.1 Installer Packages for Third-Party Software**

<table>
<thead>
<tr>
<th>Software</th>
<th>Web Services Server</th>
<th>Solutions Server</th>
<th>Cataloger Server</th>
<th>Media Server</th>
<th>Database Server</th>
<th>Media Processor for InDesign</th>
<th>MS Office Server</th>
<th>Media Generator</th>
<th>Media Processor for FLV Generator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 R2 SP1 (64 Bit) or Windows Server 2012 R2 (STANDARD EDITION) (LOCALE EN-US)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y for 2008 R2 SP1only</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
<td>-------------------------</td>
<td>-------------------------</td>
<td>-------------------------</td>
<td>-------------------------</td>
<td>-------------------------</td>
<td>-------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IIS 7.5 on Windows Server 2008 R2 SP1 or IIS 8.5 on Windows Server 2012 R2</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSMQ v6.3.9600.16384 for Windows Server 2012</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSMQ v6.1.7600.16385 for Windows Server 2008 R2 SP1</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSMQ v6.3.9600.16384 for Windows Server 2012</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSXML 4.0 SP3 Parser (msxml 4.0 SP3.msi)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft SQL Server System CLR Types (x64) (Version 10.50.1600.1) (SQLSysClrTypes.msi)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft SQL Server 2008 R2 Management Objects (x64) (Version 10.50.1600.1) (SharedManagementObjects.msi)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Database Engine x64 2010 (Version 14.0.4763.1000) (AccessDatabaseEngine_x64.exe) or Microsoft Access 2013 Runtime (Version 15.0.4517.1004) (AccessRuntime_en-us_x64.exe)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft WSE 3.0 (Microsoft WSE 3.0.msi)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Microsoft SQL Server 2008 R2, SQL Server 2012 Service Pack 3 (SP3), SQL Server 2014 Service Pack 1 (SP1) (Standard or Enterprise Edition), or SQL Server 2016 R1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe Acrobat X and XI Professional Edition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17 (vcredist_x64.exe)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Microsoft Office 2010 or Microsoft Office 2013 x64-bit (Standard or Professional)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>ImageMagick: 6.9.1-6-Q16-x64 (ImageMagick-6.9.1-6-Q16-x64-dll.exe)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>ASP.NET State Service version 4.0.30319.33440</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe InDesign CS5.5, CS6, or CC 2015 (required only if Artwork Producer is deployed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
</tbody>
</table>
Consider the following when you are installing the software that is listed in this table:

- Install Microsoft Office on a separate server in the network or on any one of the other servers (provided that the servers are within the firewall).

- **SAS Marketing Operations Management Security Recommendations:** You should use Transport Layer Security (TLS) in order to have a secure browser connection with the SAS Marketing Operations Management web server. This requirement guards against session fixation, theft of user credentials, and other attacks that depend on inspecting and forging the data exchanged between the web browser and the web server.

- While you are installing Access Database Engine x64, ensure that no 32-bit version of Microsoft Office components are installed.

- You need to disable the dialog boxes for online updates and software registration for Adobe Acrobat after you install it. Refer to “Suppress Dialog Boxes for Automatic Updates” on page 56 for more information.

- Install the Windows component Messaging Queuing Service with HTTP support enabled.

<table>
<thead>
<tr>
<th>Table 1.2</th>
<th>Installer Packages and Their Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>How Obtained</td>
</tr>
<tr>
<td>Windows Server 2008 R2 SP1 (64-bit) or Windows Server 2012 R2 (STANDARD EDITION) (LOCAL EN-US)</td>
<td>License required.</td>
</tr>
<tr>
<td>IIS 7.5 on Windows Server 2008 R2 SP1 or IIS 8.5 on Windows Server 2012 R2</td>
<td>Comes with Windows server.</td>
</tr>
<tr>
<td>MSXML 4.0 SP3 Parser (msxml 4.0 SP3.msi)</td>
<td>Freely downloadable.</td>
</tr>
<tr>
<td>Microsoft SQL Server System CLR Types (x64) (Version 10.50.1600.1) (SQLSysClrTypes.msi)</td>
<td>Redistributed via the CI Clearing House as a part of packaged prerequisite software (as a ZIP file) required to be installed before installing SAS Marketing Operations Management 6.6.</td>
</tr>
<tr>
<td>Software</td>
<td>Distribution and Requirements</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft SQL Server 2008 R2 Management Objects (x64) (Version 10.50.1600.1) (SharedManagementObjects.msi)</td>
<td>Executing database script files.</td>
</tr>
<tr>
<td>Access Database Engine x64 2010 (Version 14.0.4763.1000) (AccessDatabaseEngine_x64.exe) Or Microsoft Access 2013 Runtime (Version 15.0.4517.1004) (AccessRuntime_en-us_x64.exe)</td>
<td>Reading Microsoft Excel using OLE DB.</td>
</tr>
<tr>
<td>Microsoft WSE 3.0 (Microsoft WSE 3.0.msi)</td>
<td>Used to transfer binary files across machines.</td>
</tr>
<tr>
<td>Microsoft SQL Server 2008 R2, SQL Server 2012 Service Pack 3 (SP3), SQL Server 2014 Service Pack 1 (SP1) (Standard or Enterprise Edition), or SQL Server 2016 R1</td>
<td>Used by the database for SAS Marketing Operations Management.</td>
</tr>
<tr>
<td>Adobe Acrobat X and XI Professional Edition</td>
<td>Adobe Acrobat is required on the Microsoft Office Processor.</td>
</tr>
<tr>
<td>Microsoft Visual C++ 2008 redistributable - x64 9.0.30729.17 (vcredist_x64.exe)</td>
<td>Executing C++ COM DLLs.</td>
</tr>
<tr>
<td>Microsoft Office 2010 or Microsoft Office 2013 x64-bit (Standard or Professional)</td>
<td>Required for consolidating comments by approvals tasks and jobs, and for importing and exporting Microsoft Excel files by all modules.</td>
</tr>
</tbody>
</table>
### Client Requirements

The following software is required on the client:

- **Windows**: Microsoft Windows 7, Microsoft Windows 8, or Microsoft Windows 10
- **Macintosh**: macOS Sierra 10.12.3
- **Browsers**: Internet Explorer 10.0 or later (Windows 32-bit and 64-bit), Firefox 52.0 or later (Windows 32-bit), Google Chrome 57.0 or later (Windows 64-bit) or Safari 10.0 or later (Macintosh)

*Note*: Disable the pop-up blocker on the browsers that you use for SAS Marketing Operations Management.

- **Adobe Acrobat X or XI Professional, Standard, or Reader**: For offline approvals
- **Microsoft Office 2007, 2010, or 2013**: For opening office documents (reports) and adding comments to Microsoft Word and Microsoft Excel documents during approval
- **Adobe Flash Player 11.1 or later**: For viewing the dashboard channels, media annotations, resource manager and artwork producer, and so on
- **Adobe AIR 13.0 and later**: For using the SAS Marketing Operations Management desktop

### Pre-installation Checklist

Check for the following before you install SAS Marketing Operations Management:

1. If you are installing SAS products in addition to SAS Marketing Operations Management, be sure to install the other SAS products on a separate server. Do not
install SAS Marketing Operations Management on the same server as the other SAS products.

2. List of third-party software that is required, including the licensed software.

3. Port communication. List of ports that need to be open on the servers

4. Hardware requirements.

5. SQL Server configuration.

6. IIS settings.

7. ASP.NET state service start-up.

Port Communication

The port used during the installation should be open on all the servers on which SAS Marketing Operations Management is installed.

Configure Communication between Web Services and SAS MOM Dashboard Service

SAS MOM Dashboard service is a Windows service. This service generates the SAS Marketing Operations Management dashboard for each tenant. By default, the web services machine communicates with the SAS MOM Dashboard service using TCP on port number 16601.

You can configure an alternative port number in the DashboardService.exe.config file. This file is available in the \installation-folder\Binaries folder on the web services machine.

Figure 1.1  Port Communication between Web Services and SAS MOM Dashboard Service

To configure an alternative port:

1. Open the DashboardService.exe.config file and search for the following node:

   `<add key="TCPChannelPortNumber" value="16601"/>

2. Update value with the new port number.

3. Open the Web.config file. This file is available in the \installation-folder\ALServices folder on the web services machine. Search for the following node:

   `<add key="DashboardServiceHost" value="tcp://localhost:16601 /DashboardGenerator"/>

4. Update value with the new port number.

5. Restart the SAS MOM Dashboard service.
Configure Communication between Web Services and Media Server to SAS MOM Plug-in Service

SAS MOM plug-in service is a Windows service. This service is used to invoke the plug-ins that are registered for the service. By default, the web service and media server communicate with the plug-in service using TCP on port number 16602.

You can configure an alternative port number in the PluginService.exe.config file. This file is available in the installation-folder\Binaries folder on the web services machine and on the Media Server machine.

Figure 1.2 Port Communication between Web Services and Media Server and SAS MOM Plug-in Service

![Port Communication between Web Services and Media Server and SAS MOM Plug-in Service](image)

To configure an alternative port:

1. Open the PluginService.exe.config file and search for the following node:
   
   \[
   \text{<add key="TCPChannelPortNumber" value="16602"/>}
   \]

2. Update \text{value} with the new port number.

3. Open the Web.config file. This file is available in the installation-folder\ALServices folder on the web services machine. Search for the following node:
   
   \[
   \text{<add key="PluginServiceHost" value="tcp://localhost:16602 /PlugineServer"/>}
   \]

4. Update \text{value} with the new port number.

5. Restart the SAS MOM Plug-in Service after you change the port number on the web services machine and on the Media Server machine.

Configure Communication between the Media Processor for InDesign and the InDesign CS5.5, CS6, or CC 2015 Server

The Media Processor for the InDesign machine communicates with the InDesign CS5.5, CS6, or CC 2015 server using HTTP on port number 16603. The InDesign CS5.5, CS6, or CC 2015 Server is used to generate artwork. The artwork is used by the Artwork Producer.

You can configure an alternative port number in the InDesignCS3_Config.xml file. This file is located in the installation-folder\Configuration\XML folder on the Media Processor for InDesign machine and on the web services machine.

To configure an alternative port:

1. Open the InDesignCS3_Config.xml file and search for the following nodes:
   
   \[
   \text{<ARGUMENTS>-port 16603</ARGUMENTS>}
   \]

   \[
   \text{<INDESIGNWEBSERVICEURL>}
   \]

   \[
   \text{<DESCRIPTION>}
   \]
http://localhost:16603
</INDESIGNWEBSERVICEURL>

2. Update the port number.
3. In the Task Manager, end the InDesign Server process. Restart the SAS MOM Queue Manager Service on the Media Processor for InDesign machine and on the web services machine.

**Configure Communication between Solutions and Web Services to SAS MOM Business Events Service**

The Business Events service is a windows service. SAS MOM Business Events service is used to track changes for entities and facets. The solutions machine and the web services machine communicate with the SAS MOM Business Events service using TCP on port number 16605.

You can configure an alternative port number in the BusinessEventsService.exe.config file. This file is located in the `installation-folder\Binaries` folder on the Solutions machine and on the web services machine.

**Figure 1.3  Port Communication between Solutions and Web Services and SAS MOM Business Events Service**

To configure an alternative port:

1. Open the BusinessEventsService.exe.config file and search for the following node:
   
   ```xml
   <add key="TCPChannelPortNumber" value="16605"/>
   ```
   
   2. Update the new port number.

3. Open the Web.config file. This file is available in the `installation-folder\ALServices` folder on the web services machine. This file is also available in the `installation-folder\tenant-name` folder on the Solutions machine. You must configure the port in both Web.config files. Search for the following node:
   
   ```xml
   <add key ="BusinessEventsTCPChannelPortNumber" value="16605"/>
   ```
   
   4. Update the new port number.

5. Restart SAS MOM Business Events Service after you change the port number on the solutions machine and on the web services machine.
Chapter 2
Pre-installation Tasks

Set Up Roles and Features on Windows 2012

To set up roles and features on Windows 2012:

1. Open Server Manager. In the left navigation pane, click Dashboard.

2. In the right pane, click Add roles and features. The Add Roles and Features Wizard appears.

3. On the Before You Begin page, click Next.

4. On the Select Installation Type page, select Role-based or feature-based installation. Click Next.

5. On the Select Destination Server page, select Select a server from the server pool, and then select a server from the Server Pool list. Click Next.
6. On the Select Server Roles page, select **Web Server (IIS)** from the list of **Roles**. Click **Next**.

7. On the Select Features page, select the following options from the **Features** list, and then click **Next**.
   - .NET Framework 3.5 (includes .NET 2.0 and 3.0)
   - ASP.NET 4.5
   - HTTP Activation
   - Message Queuing Services
   - HTTP Support

8. On the Web Server Role (IIS) page, click **Next**.

9. On the Select Role Services page, select **Dynamic Content Compression, Basic Authentication**, and **Windows Authentication** from the **Role services** list. Click **Next**.

10. On the Confirm Installation Selections page, click **Install**.

11. The Installation Progress page shows the installation progress. After the installation is complete, click **Close** to close the Add Roles and Features Wizard.

---

**Set Up Roles and Features on Windows 2008**

To set up the roles and features on Windows 2008:

1. Open Server Manager. In the left navigation pane, right-click **Roles**, and then select **Add Roles**.

2. On the Before You Begin page, click **Next**. The Add Roles Wizard appears.

3. On the Select Server Roles page, select **Web Server (IIS)** and click **Next**.

4. On the Web Server (IIS) page, click **Next**.

5. On the Select Roles Services page, select the following roles:
   - **Common Http Features**: Select all the features.
   - **Application Development**: Select **ASP.NET, .NET Extensibility, ASP, CGI, ISAPI Extensions, and ISAPI Filters**.
   - **Health and Diagnostics**: Select **HTTP Logging, Request Monitor, and Request Filtering**.
   - **Performance**: Select **Static Content Compression**.
   - **Management Tools**: Select **IIS Management Console**. Under **IIS 6 Management Compatibility**, select **IIS 6 Metabase Compatibility**.
   - **FTP Publishing Service**: Select all the features.

   Click **Next**.

6. On the Confirmation page, click **Next**.

7. On the Progress page, click **Next**.

8. On the Installation Results page, click **Close**.
Set up the features by completing the following steps:

To set up features on Windows 2008:

1. Open the Server Manager. In the left navigation pane, right-click **Features**, and then select **Add Features**. The Add Features Wizard appears.

2. On the Select Features page, select the following features:
   - **.NET Framework 3.0 Features (Installed)**: Select all the features.
   - **WCF Activation**: Select all the features.
   - **Message Queuing**: Select **Message Queuing Server** and **HTTP Support**.
     
     Click **Next**.

3. On the Web Server (IIS) page, click **Next**.

4. On the Roles Services page, click **Next**.

5. On the Progress page, click **Next**.

6. On the Installation Results page, click **Close**.

---

### Installing Third-Party Software

#### Install the MSXML 4.0 SP3 Parser

To install the MSXML 4.0 SP3 parser:

1. Run the MSXML 4.0 SP3.msi file. The Setup Wizard appears.

2. On the End-User License Agreement page, read and accept the terms in the license agreement, and then click **Next**.

3. On the Customer Information page, enter your user name and organization name, and then click **Next**.

4. On the Choose Setup Type page, click **Install Now**.

5. After the installation is complete, click **Finish** to close the Setup Wizard.

#### Install the Microsoft SQL Server System CLR Types (x64)

To install Microsoft SQL Server System CLR Types (x64):

1. Run the SQLSysClrTypes.msi file. The Installation Wizard appears. Click **Next**.

2. On the License Agreement page, read and accept the terms in the license agreement, and then click **Next**.

3. On the Registration Information page, enter your user name and organization name, and then click **Next**.

4. On the Ready to Install the Program page, click **Install**.

5. After the installation is complete, click **Finish** to close the Installation Wizard.
Install the Microsoft SQL Server 2008 R2 Management Objects (x64)

To install the Microsoft SQL Server 2008 R2 Management Objects (x64):
1. Run the SharedManagementObjects.msi file. The Installation Wizard appears. Click Next.
2. On the License Agreement page, read and accept the terms in the license agreement, and then click Next.
3. On the Registration Information page, enter your user name and organization name, and then click Next.
4. On the Ready to Install the Program page, click Install.
5. After the installation is complete, click Finish to close the Installation Wizard.

Install the Microsoft Access Database Engine 2010 x64

Note: Install Microsoft Access Database Engine x64 2010 when Microsoft Office 2010 x64-bit is installed. Ensure that no 32-bit version of MS Office components are installed.

To install the Access Database Engine x64 2010:
1. Run the AccessDatabaseEngine_x64.exe file.
2. Read and accept the terms in the license agreement, and then click Continue.
3. After the installation is complete, click Close to close the Installation Wizard.

Install Microsoft Access 2013 Runtime

Note: Install Microsoft Access 2013 Runtime when Microsoft Office 2013 x64-bit is installed. Ensure that no Microsoft Office 32-bit components are installed.

To install Microsoft Access 2013 Runtime:
1. Run the AccessRuntime_en-us_x64.exe file.
2. Read and accept the terms in the license agreement, and then click Continue.
3. After the installation is complete, click Close to close the Installation Wizard.

Install Microsoft WSE 3.0

To install Microsoft WSE 3.0:
1. Run the Microsoft WSE 3.0.msi file. The Installation Wizard appears. Click Next.
2. On the License Agreement page, read and accept the terms in the license agreement, and then click Next.
3. On the Setup Type page, select Runtime setup type (default), and then click Next.
4. On the Ready to Install the Program page, click Install.
5. After the installation is complete, click Finish to close the Installation Wizard.
**Install Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17**

To install Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17:
1. Run the vcredist_x64.exe file. The Installation Wizard appears. Click **Next**.
2. On the License Terms page, read and accept the license terms, and then click **Install**.
3. After the installation is complete, click **Finish** to close the Installation Wizard.

**Install the SAP Crystal Reports Runtime Engine for .NET Framework (64-bit)**

To install the SAP Crystal Reports runtime engine for .NET Framework (64-bit):
1. Go to [http://scn.sap.com/docs/DOC-7824](http://scn.sap.com/docs/DOC-7824) and download the latest SAP Crystal Reports runtime engine 64-bit installer for .NET framework. Run the installer. The Installation Wizard appears. Click **Next**.
2. On the License Agreement page, read and accept the license terms, and then click **Next**.
3. On the Start Installation page, click **Next**.
4. After the installation is complete, click **Finish** to close the Installation Wizard.

**Install ImageMagick-6.9.1-6-Q16-x64**

To install ImageMagick 6.9.1-6-Q16-x64:
1. Run the ImageMagick-6.9.1-6-Q16-x64-dll.exe file. The Setup Wizard appears. Click **Next**.
2. On the License Agreement page, read and accept the license terms, and click **Next**.
3. On the Information page, read the instructions, and click **Next**.
4. On the Select Destination Location page, specify the location for the installation, and click **Next**.
5. On the Select Start Menu Folder page, specify the location where the program’s shortcut should be created. Click **Next**.
6. On the Select Additional Tasks page, select **Create a desktop icon** and **Add application directory to your system path**, and click **Next**.
7. On the Ready to Install page, click **Install**.
8. After the installation in complete, the Information page shows the instructions for verifying the installation. To continue with the setup, click **Next**.
9. After the setup is complete, click **Finish** to close the Setup Wizard.

**Install GPL Ghostscript**

2. In the self-extractor dialog box, click Setup.

3. In the **GPL Ghostscript Setup** dialog box, specify the locations for installation and shortcuts. Click Install.

---

**For SAS Marketing Operations Management Desktop**

SAS Marketing Operations Management Desktop is an extended part of the SAS Marketing Operations Management solution, which is built on the AIR platform from Adobe. The Desktop helps catalog digital data in bulk or batch into the Digital Library. You can easily associate metadata or business information with it (which is not possible through the web-based solution).

**File Sharing:**

1. The Desktop connects to the Cataloger Server to transfer the selected files to catalog into the SAS Marketing Operations Management system.

2. The Desktop then connects to the Solution Server to validate the user and retrieve the section hierarchy the user has access to.

**System Requirements for using the Desktop:**

- Ensure that a minimum of 5 MB disk space is available.
- To deploy the SAS Marketing Operations Management Desktop on the end-user desktop machine, you must connect to the SAS Marketing Operations Management web server and the cataloger machine. Either the machine’s IP address or its DNS name should be publicly visible via the Internet.

---

**Configuring the SQL Server**

**Set Up the Communication Protocol**

To set up the communication protocol for the SQL server:

1. Open SQL Server Configuration Manager.

2. Expand **SQL Server Network Configuration**, and select the **Client Protocols** option.

3. Enable the **TCP/IP** protocol.

**Set the Time-out for Query Execution**

To set the query execution time-out for the SQL Server Management Studio to 0 (that is, to be infinite):

1. Open Microsoft SQL Server Management Studio.

2. Connect to the database server by supplying the appropriate credentials.
4. In the tree view, expand Query Execution ⇒ SQL Server.
5. Click SQL Server. A list of settings is displayed. Set the value of the execution time-out to 0. Save the setting.
6. Close all instances of SQL Server Management Studio and restart the SQL Server (MSSQLSERVER) from the Services panel.

Create a SQL Server-Level Login Account

To create a SAS Marketing Operations Management database user login account in SQL Server:
1. Launch SQL Server Management Studio.
2. Expand the Security folder in the left pane.
3. Right-click Logins and select New Login. The Login - New dialog box appears.

**Figure 2.1 Login-New Dialog Box**
4. Specify the following information in the Login - New dialog box:
   a. Enter the login name.
   b. Select **SQL Server authentication** and enter the password for this login.
   c. Clear the **Enforce password expiration** check box.
   d. Select **master** as the default database.

---

**Verify IIS Settings**

Ensure that the web service extensions section for the default website allows ASP.NET for version v4.0.30319. Go to the Internet Information Service (IIS) Manager, click on the <Server Name> item in the **Connections** menu on the left pane. In the IIS section, double-click the **ISAPI and CGI Restrictions** icon.

Ensure that **Allowed** is set for ASP.NET v4.0.30319 for 64 bit.

*Figure 2.2  ISAPI and CGI Restrictions*

<table>
<thead>
<tr>
<th>Description</th>
<th>Restriction</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Server Pages</td>
<td>Allowed</td>
<td>C:\Windows\system32\aspplug.dll</td>
</tr>
<tr>
<td>ASP.NET v2.0.50727</td>
<td>Allowed</td>
<td>C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll</td>
</tr>
<tr>
<td>ASP.NET v3.0.30319</td>
<td>Allowed</td>
<td>C:\Windows\Microsoft.NET\Framework\v3.0.30319\aspnet_isapi.dll</td>
</tr>
<tr>
<td>ASP.NET v4.0.30319</td>
<td>Allowed</td>
<td>C:\Windows\Microsoft.NET\Framework\v4.0.30319\aspnet_isapi.dll</td>
</tr>
<tr>
<td>WebDAV</td>
<td>Allowed</td>
<td>C:\Windows\system32\aspnet-webdav.dll</td>
</tr>
</tbody>
</table>

---

**Start ASP.Net State Service**

Start the ASP.Net State Service if it is not already started. Ensure that the start-up type for this service is automatic.
Chapter 3
Installing SAS Marketing Operations Management

Installing SAS Marketing Operations Management

Initial Steps

If you are installing an individual server in the target configuration, you might need to select one installer component or multiple installer components. How many you select is dependent on which tiers are to be hosted on that server. During the installation process, the installation folder is created and a SASMOMTools folder is created on the same drive. You must restart every server after the installation process is complete.

You can install SAS Marketing Operations Management application on a single server or on multiple servers.

Note: This documentation refers to the user that is used for the installation as MOMUSR, which can be either the local system user or the domain user.

1. In the SAS Software Depot, double-click Setup.
2. Select the language, and click OK.
3. On the Select Deployment Task page, select Install SAS software. Click Next.
5. On the Select Products to Install page, select SAS Marketing Operations Management, and click Next.
6. On the Select Regional Settings page, select English for the locale, and click Next.
7. Depending on whether you want a single-machine installation or a multiple-machine installation, perform the relevant steps:
   • For single-machine installation, see “Additional Steps for a Single-Machine Installation” on page 22.
   • For multiple-machine installation, see “Additional Steps for a Multiple-Machine Installation” on page 22.
Additional Steps for a Single-Machine Installation

Before you begin the following task, complete the steps described in “Initial Steps” on page 21.

1. On the SAS Marketing Operations Management Setup page, select all the components that you want to install. Click Browse to select the destination folder, and then click Next.

   Note: If you anticipate high usage of video files, the Media Processor for FLV generator should be on an independent machine because a considerable amount of memory is required. If you do not install it on a separate machine, all the other requests might be delayed.

2. On the Specify User Type page, select the domain user or the local system user. Enter the user name and password, and click Next. The password for the local system user must meet the password policy requirements for the local machine. The local system user is created during the installation process. The domain user must belong to the administrators group on the local machine.

3. On the Server Details page, enter the server name or the IP address of the machines on which Solutions, Web Services, and Media Server are installed. Select a communication protocol, enter the DNS name or IP address for access via Internet and the port number, and click Next. The default port number for HTTP is 80 and for HTTPS is 443.

4. On the Number of Catalogers page, select No for the Will this be set up with two catalogers field. Click Next. On the Catalogers Details page, enter the cataloger server name or IP address.

   Note: In a single-machine configuration, there can be only one cataloger.

5. On the Additional Server Details page, enter the name or IP address for the machines on which Media Generator, FLV Generator, MSOffice Processor, and InDesign Processor are installed, and click Next.

6. In the Port Number window, enter the internal port number.

7. On the Script Execution page, choose how you want to execute the scripts, and then click Next. The script is executed only when you are migrating the system to a newer version and not for an initial installation. Continue with the default selection.

8. On the E-mail Information page, enter the first name, last name, and email address of the user who will receive email notifications from the system.

9. After the file system check is complete, click Next.


11. After the installation is complete, click Next. On the next page, click Finish to close the SAS Deployment Wizard.

Additional Steps for a Multiple-Machine Installation

Prerequisites

Run the SAS Deployment Wizard on each machine in the configuration. All the components need to be installed on the same drive and on the same network. The password for the MOMUSR should be the same on all the machines.
The following figure shows a sample deployment of SAS Marketing Operations Management on multiple servers. The figure shows a deployment that uses two catalogers, primary and secondary. If you are using only one cataloger, then you need to install the primary cataloger on the Cataloger Server.

**Figure 3.1  Suggested Deployment Scenario**

Suggested Deployment Scenario

- Web Services (Application Tier)
- Microsoft Office
- Cataloger Server (Secondary)
- Media Server
- Media Generator
- Media Processor for FLV Generator
- Solutions (Web Server Tier)
- Cataloger (Primary)
- Media Processor for InDesign

SAS Marketing Operations Management 6.6 should be installed on the servers in the setup in the following sequence:

1. Web Services (Application) Server
2. Solutions Server
3. Cataloger Server and Media Server
4. All Media Processor servers

**Install Web Services and Microsoft Office Processor**

1. On the SAS Marketing Operations Management Setup page, select Web Services and Microsoft Office Processor. Click Browse to select the destination folder, and then click Next.

2. On the Specify User Type page, select the domain user or the local system user. Enter the user name and password, and click Next. The password for the local system user must meet the password policy requirements of the local machine. The local system user is created during the installation process. The domain user must belong to the administrators group on the local machine. Make sure you enter the same user credentials on all the machines in the configuration.

3. On the Server Details page, enter the server name or the IP address of the machines on which Solutions, Web Services, and Media Server are installed. Select a communication protocol, enter the DNS name or IP address for access via Internet and the port number, and click Next. The default port number for HTTP is 80 and for HTTPS is 443. Make sure you select the same communication protocol and enter the same port number on all the machines in the configuration.

4. On the Number of Catalogers page:
   - If you are installing two catalogers, select Yes for the Will this be set up with two catalogers field. Click Next.
   - If you are installing only one cataloger, select No for the Will this be set up with two catalogers field. Click Next.
5. On the Cataloger Details page, enter the cataloger details, and then click Next.

6. On the Additional Server Details page, enter the name or IP address for the machines on which Media Generator, FLV Generator, MSOffice Processor, and InDesign Processor are installed, and click Next.

7. In the Port Number window, enter the internal port number. Make sure the port number is the same on all machines.

8. On the Script Execution page, choose how you want to execute the scripts, and then click Next. The script is executed only when you are migrating the system to a newer version and not for an initial installation. Continue with the default selection.

9. On the E-mail Information page, enter the first name, last name, and email address of the user who will receive email notifications from the system.

10. After the file system check is complete, click Next.


12. When you are prompted for a reboot, click Allow.

13. After the installation is complete, click Next. On the next page, click Finish to close the SAS Deployment Wizard.

Note: Be sure to restart the web services server before you install the other components such as web server, media processor, cataloger, and media server.

**Install Solutions and Primary Cataloger on the Web Server Tier**

If you are installing only one cataloger, you must install that cataloger on the Cataloger Server, not on the web server tier.

To install solutions and the primary cataloger (in a two-cataloger deployment) on the web server tier:

1. On the SAS Marketing Operations Management Setup page, select Solutions and Cataloger. Click Browse to select the destination folder, and then click Next.

2. On the Specify User Type page, select the domain user or the local system user. Enter the user name and password, and click Next. The password for the local system user must meet the password policy requirements of the local machine. The local system user is created during the installation process. The domain user must belong to the administrators group on the local machine. Make sure you enter the same user credentials on all the machines in the configuration.

3. On the Server Details page, enter the server name or the IP address of the machines on which Solutions, Web Services, and Media Server are installed. Select a communication protocol, enter the DNS name or IP address for access via Internet and the port number, and click Next. The default port number for HTTP is 80 and for HTTPS is 443. The default port number for HTTP is 80 and for HTTPS is 443. Make sure you select the same communication protocol and enter the same port number on all the machines in the configuration.

4. On the Number of Catalogers page:
   - If you are installing two catalogers, select Yes for the Will this be set up with two catalogers field. Click Next.
   - If you are installing only one cataloger, select No for the Will this be set up with two catalogers field. Click Next.

5. On the Cataloger Details page, enter the cataloger details and specify whether this machine is the primary cataloger. Click Next.
6. On the Additional Server Details page, enter the name or IP address for the machines on which Media Generator, FLV Generator, MSOffice Processor, and InDesign Processor are installed. Select whether these servers are accessible through a UNC path, and click Next.

7. In the Port Number window, enter the internal port number. Make sure the port number is the same on all machines.

8. After the file system check is complete, click Next.

9. When you are prompted for a reboot, click Allow.

10. After the installation is complete, click Next. On the next page, click Finish to close the SAS Deployment Wizard.

**Install Secondary (or Only) Cataloger, Media Server, Media Generator, and Media Processor for FLV Generator**

If you are installing only one cataloger, you must install that cataloger on this tier.

1. On the SAS Marketing Operations Management Setup page, select Cataloger, Media Processor for FLV Generator, Media Server, and Media Generator. Click Browse to select the destination folder, and then click Next.

2. On the Specify User Type page, select the domain user or the local system user. Enter the user name and password, and click Next. The password for the local system user must meet the password policy requirements of the local machine. The local system user is created during the installation process. The domain user must belong to the administrators group on the local machine. Make sure you enter the same user credentials on all the machines in the configuration.

3. On the Server Details page, enter the server name or the IP address of the machines on which Solutions, Web Services, and Media Server are installed. Select a communication protocol, enter the DNS name or IP address for access via Internet and the port number, and click Next. The default port number for HTTP is 80 and for HTTPS is 443. Make sure you select the same communication protocol and enter the same port number on all the machines in the configuration.

4. On the Number of Catalogers page:
   - If you are installing two catalogers, select Yes for the Will this be set up with two catalogers field. Click Next.
   - If you are installing only one cataloger, select No for the Will this be set up with two catalogers field. Click Next.

5. On the Cataloger Details page, enter the cataloger details and specify whether this machine is the primary cataloger. Click Next.

6. On the Additional Server Details page, enter the name or IP address for the machines on which Media Generator, FLV Generator, MSOffice Processor, and InDesign Processor are installed. Select whether these servers are accessible through a UNC path and click Next.

7. In the Port Number window, enter the internal port number. Make sure the port number is the same on all machines.

8. On the E-mail Information page, enter the first name, last name, and email address of the user who will receive email notifications from the system.

9. After the file system check is complete, click Next.

10. After the installation is complete, click Finish to close the SAS Deployment Wizard.
Note: When you have completed the installation, restart the machine. If you are installing SAS Marketing Operations Management on multiple machines, restart each machine after installation.

**Install Media Processor for InDesign**

1. On the SAS Marketing Operations Management Setup page, select Media Processor for InDesign. Click Browse to select the destination folder, and then click Next.

2. On the Server Details page, enter the server name or the IP address of the machines on which Solutions, Web Services, and Media Server are installed. Select a communication protocol, enter the DNS Name or IP address for access via Internet and the port number, and click Next. The default port number for HTTP is 80 and for HTTPS is 443. Make sure you select the same communication protocol and enter the same port number on all the machines in the configuration.

3. On the Number of Catalogers page:
   - If you are installing two catalogers, select Yes for the Will this be set up with two catalogers field. Click Next.
   - If you are installing only one cataloger, select No for the Will this be set up with two catalogers field. Click Next.

4. On the Cataloger Details page, enter the cataloger details and specify whether this machine is the primary cataloger. Click Next.

5. On the Additional Server Details page, enter the name or IP address for the machines on which Media Generator, FLV Generator, MSOffice Processor, and InDesign Processor are installed, and click Next.

6. In the Port Number window, enter the internal port number. Make sure the port number is the same on all machines.

7. On the E-mail Information page, enter the first name, last name, and email address of the user who will receive email notifications from the system.

8. After the file system check is complete, click Next.

9. After the installation is complete, click Finish to close the SAS Deployment Wizard.

Note: After you complete the installation, restart all the servers.
Part 2

Post-installation

Chapter 4
Post-installation Tasks .................................................. 29

Chapter 5
Tenant-Related Configuration Tasks ................................. 35

Chapter 6
Additional Configuration Tasks ................................. 45

Chapter 7
Uninstalling SAS Marketing Operations Management ............... 63
Chapter 4
Post-installation Tasks

Overview

After you complete the installation, restart the machine. If you have performed a multi-machine installation, restart each machine after the installation process is complete. Refer to SAS Marketing Operations Management: Quick Start Guide for a quick installation verification and application functionality validation.

After the installation is completed, check the log files for any exceptions. The log files (InstallationSettingsLog.txt and CreateTenant_Tenant Name.txt) are stored under the Installation folder on the machine.

Confirm Installation of Windows Services

The Windows services are installed on all the servers where SAS Marketing Operations Management is installed. Go to the services panel by clicking on Start ⇒ Administrative Tools ⇒ Server Manager, and then click the Services item. Right-click each service and start the service. The installer sets the service to automatic and sets the selected services to run under the MOMUSR account.

Note: If any of the services are not installed, launch the InstallServices.bat file located under <Installation Path>/Binaries and refer to “Running a Service under the MOMUSR Context” on page 72 for more information. The Installation folder is in the location that you specified when you installed SAS Marketing Operations Management.

Note:
You can start the SAS MOM Cataloger and SAS MOM File Watcher services only after you have set the mount points for a tenant. You set the mount points after you create the tenant. See “Create the Tenant” on page 35.

You can start the SAS MOM Format Watcher service only after you have set the format watcher mount point for a tenant. You set the format watcher mount point after you create the tenant. See “Create the Tenant” on page 35.

The DAM Job copy service and Replication service are required only if you are using a setup where an external setup is available. These two services are not installed by the installer, and you need to install them manually. To install these services, run the following batch files, which are located at `<Installation folder>/Binaries`:

- InstallDAMJobCopyServices.bat: Install this service on the network machine on which the cataloger mount point for external setup is configured.

- InstallReplicationAgentServices.bat: Install this service on the solutions machine.

Confirm successful installation of all the following services by launching the Services applet from the Administrative Tools control panel:

Note: You can start the services mentioned in the table in any order.

Table 4.1 Services

<table>
<thead>
<tr>
<th>Services</th>
<th>.exe File</th>
<th>User Account</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS MOM Back-Office Service</td>
<td>ALBackOfficeService.exe</td>
<td>Local System</td>
<td>Web Services</td>
<td>This service executes back-end processes at a specified time daily within SAS Marketing Operations Management for each tenant.</td>
</tr>
<tr>
<td>SAS MOM Dashboard Service</td>
<td>ALDashboardService.exe</td>
<td>Local System</td>
<td>Web Services</td>
<td>This service generates the SAS Marketing Operations Management dashboard for each tenant.</td>
</tr>
<tr>
<td>SAS MOM Notification Service</td>
<td>ALNotificationService.exe</td>
<td>Local System</td>
<td>Web Services</td>
<td>This service sends email notifications to the SAS Marketing Operations Management users.</td>
</tr>
<tr>
<td>SAS MOM Text Cataloger Service</td>
<td>ALTextCatalogerService.exe</td>
<td>Local System</td>
<td>Web Services</td>
<td>This service extracts text from specific searchable files and make it available for text searches.</td>
</tr>
<tr>
<td>SAS MOM Queue Manager Service</td>
<td>ALQueueManagerService.exe</td>
<td>MOMUSR</td>
<td>All components.</td>
<td>This service is used to process the messages added in SAS Marketing Operations Management queues.</td>
</tr>
<tr>
<td>Services</td>
<td>.exe File</td>
<td>User Account</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------</td>
<td>--------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAS MOM Cataloger Service</td>
<td>ALCatalogerService.exe</td>
<td>MOMUSR</td>
<td>Cataloger</td>
<td>This service processes the catalog jobs for each tenant.</td>
</tr>
<tr>
<td>SAS MOM FileWatcher Service</td>
<td>ALFileWatcherService.exe</td>
<td>MOMUSR</td>
<td>Cataloger</td>
<td>This service monitors the cataloger mount point on the arrival of a new catalog job for each tenant.</td>
</tr>
<tr>
<td>SAS MOM FormatWatcher Service</td>
<td>ALFormatWatcherService.exe</td>
<td>Local System</td>
<td>Solutions</td>
<td>This service monitors the format watcher mount point for a new format job and processes it for each tenant. This service is used for the Artwork Producer.</td>
</tr>
<tr>
<td>SAS MOM PluginService Service</td>
<td>ALPluginService.exe</td>
<td>MOMUSR</td>
<td>Web Services, Media Server</td>
<td>This service invokes the plug-ins that are registered for the service.</td>
</tr>
<tr>
<td>SAS MOM BusinessEvents Service</td>
<td>ALBusinessEventsService.exe</td>
<td>MOMUSR</td>
<td>Solutions, web Services</td>
<td>This service is used to track changes for entities and facets.</td>
</tr>
<tr>
<td>SAS MOM Report Scheduler</td>
<td>ALReportScheduler.exe</td>
<td>Local System</td>
<td>Web Services</td>
<td>This service sends scheduled SAS Marketing Operations Management reports.</td>
</tr>
<tr>
<td>SAS MOM Service Monitor</td>
<td>ALServiceMonitor.exe</td>
<td>MOMUSR</td>
<td>All the Machines</td>
<td>This service monitors other SAS Marketing Operations Management services.</td>
</tr>
<tr>
<td>SAS MOM NTFS Monitoring Service</td>
<td>ALNTFSMonitoringService.exe</td>
<td>Local System</td>
<td>Web Services</td>
<td>This service monitors the specified NTFS folder and adds events in the MSMQ on the NTFS change event. This service functions across all the tenants.</td>
</tr>
</tbody>
</table>

**Note:** The SAS MOM Service Monitor monitors all the SAS Marketing Operations Management services on all the machines on which SAS Marketing Operations Management is installed. If any of the services stop for any reason, this service restarts it. You can adjust the interval of the polling in the ALServiceMonitorConfiguration.xml file. For more information about the SAS MOM Service Monitor configuration, see “SAS Marketing Operations Management Service Monitor Configuration” on page 61.
Microsoft Office Processor Machine Settings

MOMUSR is automatically created by the installer. After this user is created, complete the following steps on the machine on which Microsoft Office Processor is installed.

To consolidate Microsoft Word documents in an Approval job or in a Marketing Workbench task:
1. Log on as MOMUSR and launch Microsoft Word on the web services machine.
2. Select Use recommended settings, and click Accept.
3. On the Welcome page, click Next.
4. On the Sign in page, click No thanks, maybe later.
5. On the Meet SkyDrive page, click Next.
6. On the last page, click All done!

For Adobe Acrobat:
1. Launch Adobe Acrobat X or XI Professional.
2. In the Getting Started dialog box, select Do not show at startup, and then close the dialog box.
3. Log off as MOMUSR from this machine.

Configuring Security Permissions

To configure the security permissions:
1. On the server, select Start ⇒ Run and type Dcomcnfg.exe.
3. For each application listed in Table 4.2 on page 33, complete the steps from Step 4 on page 32 onwards.
4. Right-click on the application and select Properties.
5. On the Security tab, specify the following settings:
   • Launch and Activation Permissions: If you select the Customize option, click Edit. Add users in the Group or user names section. Allow Local Launch, Remote Launch, Local Activation and Remote Activation permissions.
   • Access Permissions: If you select the Customize option, click Edit. Add users in the Group or user names section. Allow Local access and Remote access permissions.
   • Configuration Permissions: If you select the Customize option, click Edit. Add users in the Group or user names section. Allow Full Control to the user.

Note: For the Digital Asset Management module only: If the Digital Asset Management module supports a shared network folder, specify the DCOM
settings for MOMUSR on the Application Services, Media Services, and Cataloger tiers.

Table 4.2  DCOMConfig

<table>
<thead>
<tr>
<th>User: Network Service, MOMUSR</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions</td>
<td>Microsoft Excel</td>
</tr>
<tr>
<td>Launch and Activation</td>
<td>Customize</td>
</tr>
<tr>
<td>Access</td>
<td>Use default</td>
</tr>
<tr>
<td>Configuration</td>
<td>Customize</td>
</tr>
</tbody>
</table>

6. On the Identity tab, complete the following steps for all applications in the DCOM configuration:
   a. Select the This User radio button.
   b. Click Browse to select MOMUSR.
   c. Add the user to the Group or User Names box. Provide the appropriate password for the Password and Confirm Password fields.
   d. Click Apply to apply the configuration, and then click OK.

7. If you specified DCOM settings in the previous steps but the Queue Manager Service fails to launch the respective applications, then change the DCOM configuration settings:
   a. Go to Computer Management ⇒ System tools ⇒ Local Users and Groups, and add the MOMUSR to the Administrators group.
   b. Go to the DCOM Config settings, right-click the item, and select Properties.
   c. Click the Identity tab and select The Launching User radio button.
   d. Click Apply and OK to save the settings.

Configure Settings for a Digital Library That Supports a Shared Network Folder

To set up the configuration:

1. Create a shared drive folder on any machine that is on the same network as the installation machines.
2. Provide MOMUSR with complete access to the shared drive folder.
   Note: Specify access for MOMUSR on both the Security Permissions tab and the Sharing Permissions tab.
3. Allow Full Control to MOMUSR for the following locations:
• **Installation** folder
• Windows **Temp** folder
• **Temporary ASP.NET Files** folder .NET framework
• C:\Temp (Temp folder set in environment variable)
• On the Network folder that is created

*Note:* If the installation is in the DMZ, that is, if SAS Marketing Operations Management is installed on an external machine, then add the following key in the `<tenant>\web.config` directory on the external machine: `<add key="CURRENTNETWORK" value="EXTERNAL" />`. When you add this key, functionality that is specific to network folder usage is not shown on the external machine because that machine cannot access the network folder.
Chapter 5
Tenant-Related Configuration Tasks

Configuring the Tenant .................................................. 35
Create the Tenant .......................................................... 35
Folder Permissions ......................................................... 35
Create the Cataloger Mount Point ...................................... 37

Configuring Additional Settings for the Tenant ....................... 38
Changing the Default Session Time-out Value ....................... 38
Granting Permission to the Database .................................. 38
Grant Permissions to the Database User ............................... 38
Disable HTTP ................................................................ 41
Configure FTP Sites for the Artwork Producer ...................... 42
Restart the Windows Services ............................................. 43
Verify Scheduled Tasks ..................................................... 43

Configuring the Tenant

Create the Tenant

To create the database automatically and create the tenant:

1. Go to SQL Server Management Studio by selecting Start ⇒ Programs ⇒ Microsoft SQL Server ⇒ Security ⇒ Logins.
2. Double-click the SAS Marketing Operations Management database user account that you created in “Create an SQL Server-Level Login Account” on page 19.
3. Select Server Roles from the left pane.
4. Select the dbcreator and public server roles for the new login. Click OK.
5. Remove the Read-Only setting for the installation folder (which was created on all machines during the setup process). Grant Write access to this folder.
6. Create the tenant by double-clicking the TenantCreation application located in the folder <Installation Folder>\Tenant Creation.
Enter the following information:

a. Enter a tenant name. You can use only English alphabets (A–Z) and Arabic numerals (0–9) for the tenant name. The tenant name cannot start with a numeric character, cannot contain spaces, and cannot contain the string \texttt{xml} as part of the name.

b. Select SQL Server as the database type. The database server instance is populated as soon as you select the database type. Do not change it unless required. For SQL Server, the value is Default.

c. Enter a database machine name or an IP address.

d. Enter the database name (the tenant creation utility creates the database). The database user name and password are the credentials of the SQL Server login that were created in “Create an SQL Server-Level Login Account” on page 19.

If the Create Database Automatically field is set to Yes, then the tenant creation utility creates the database. If an empty database already exists, then the tenant creation utility creates the schema for the tenant. If the Create Database Automatically is set to No, then the database needs to be created manually.

e. Keep the default value database\_name\_ODS in the ODS Database Name field.

f. Specify the installation path that you selected during installation in the Server Installation Path field.

g. Keep the default value True in the Auditing field.

h. Specify values in the Mount Point and XML Mount Point fields. On the web services machine, the MountPoint (for files) and the XML mount point should be located in a folder other than the tenant folder. It can reside within the installation folder but not under the tenant folder because this setup creates a performance issue. Every tenant should have an individual mount point and XML mount point.

i. Specify the outbox path. The virtual directory DashboardImages points to the Outbox folder of the tenant. If you have more than one tenant in a single-machine installation, all the tenants should point to the same Outbox folder. If you have a multiple-machine installation, the DashboardImages directory points to the DashboardImages folder on the solutions machine.
Note: The outbox path that you specify for the tenant should be such that the same drive can be specified on the Media Server machine.

j. In the Max File Count field, specify the maximum number of files that can reside within a folder under the mount point or vaults. When the file count reaches the maximum count, a new folder is created and the subsequent files are put under this folder.

7. If any errors are generated while the tenant is being created, view the error details in a log file that is created in the pathInstallation Folder\CreateTenant_TenantName.txt. This log file is created only on the solutions machine.

Folder Permissions

After you have created the tenant, give permissions for the following folders using the instructions in “Grant Folder Permissions” on page 71. If these folders are in the installation folder, then you do not need to give permissions to them.

- MountPoint
- XMLMountPoint
- OutBox

Create the Cataloger Mount Point

To create the cataloger mount point:

1. Enter the following URL in a browser to view the Login screen for the tenant:
   http://IP Address/Tenant Name

2. Log on to SAS Marketing Operations Management using the following credentials:
   - User Name: admin
   - Password: sa
   Change the password for the admin user when prompted.

3. In the left pane under Administration, click the Settings link to navigate to the SAS Marketing Operations Management Settings page.

4. In the Cataloger Settings section, specify the mount point for the primary cataloger in the MountPoint field. If you have a multi-machine setup, specify the mount point path as a UNC path (for example, \machine-name\shared-folder-name\cataloger-mount-point). The mount point folder should be a shared folder and should not already exist.

   Specify the secondary mount point if you have a secondary cataloger. The expected input for this field is the path in the file system to which the batch cataloger jobs will be submitted.

   Note: If your Cataloger and Media Server are on the same machine, then the mount points are created after you save these settings. If your Cataloger and Media Server are on separate machines, you create the shared folder in a later step. The File Watcher Service polls this folder to detect the arrival of batch cataloging jobs. See “Restart the Windows Services” on page 43 for more information about restarting the windows services.

5. Save the settings.
6. If your Cataloger and the Media Server are on separate machines:
   a. Create a shared folder on the Cataloger machine to be your mount point. You specified the path to this folder in the **MountPoint** field on the SAS Marketing Operations Management Settings page.
   b. Configure MOMUSR with the same password on both the Cataloger and Media Server machine.

7. Right-click on the shared folder that you specified as the Cataloger mount point. On the **Security Permissions** tab and the **Sharing Permissions** tab, grant complete access to the following users:
   • MOMUSR
   • IUSR
   • NETWORK SERVICE

8. Start or restart the Cataloger and File Watcher services under the MOMUSR account.

---

### Configuring Additional Settings for the Tenant

#### Changing the Default Session Time-out Value

You can change the session time-out value in the *Tenant*.xml according to the client requirements. These changes should be done on the web server as well as the application server. Follow the steps:

1. Open the *Tenant*.xml present under **Installation Folder\Configuration\XML**.
2. Navigate to the **SESSION** node under the root node **CONFIGURATION**.
3. Set the **DatabaseUpdateInterval** attribute value to 10% of the **Timeout** attribute value. For example, if the **Timeout** value is 1800 then the **DatabaseUpdateInterval** value should be set as 180. Make sure this value is a whole number and does not contain decimal values.
4. Save the *Tenant*.xml.

#### Granting Permission to the Database

Be sure to follow the best practices specified by the customer organization for database space issues related to log files.

This setting is applicable for the SAS Marketing Operations Management ODS database, which is created by the tenant application.

#### Grant Permissions to the Database User

In day-to-day usage, the SAS Marketing Operations Management database user does not require a creator or owner permission. You need to grant only a limited set of permissions to the SAS Marketing Operations Management database user on the Tenant and the ODS database individually. The SAS Marketing Operations Management database user login account is the user login account that you created in “Create an SQL
Server-Level Login Account” on page 19, and the database user corresponds to this login account.

*Note:* Complete the steps using the sa login account or a user account that has permissions to create a user and role, change the user role membership and database ownership, and grant or deny the database permission.

To grant the required permissions:

1. Ensure that no one is using SAS Marketing Operations Management. Stop the SAS Marketing Operations Management services and IIS on all the servers and ensure that none of the SAS Marketing Operations Management scheduled tasks are running.

2. Go to Databases ⇒ Database ⇒ Security ⇒ Roles ⇒ Database Roles. Right-click Database Roles and select New Database Role. Create the role SASMOM Role, and click OK.

3. Double-click the SASMOM Role role, and then click Securables in the left pane.

4. In the right pane, search the Tenant database. Select the following permissions:

*Table 5.1 Permissions List*

<table>
<thead>
<tr>
<th>Grant List</th>
<th>Deny List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alter</td>
<td>Alter any application role</td>
</tr>
<tr>
<td>Authenticate</td>
<td>Alter any assembly</td>
</tr>
<tr>
<td>Connect</td>
<td>Alter any asymmetric key</td>
</tr>
<tr>
<td>Note: Do not select this access on SQL Server 2008 R2.</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Alter any certificate</td>
</tr>
<tr>
<td>Execute</td>
<td>Alter any contract</td>
</tr>
<tr>
<td>Insert</td>
<td>Alter any database audit</td>
</tr>
<tr>
<td>Select</td>
<td>Alter any database DDL trigger</td>
</tr>
<tr>
<td>Update</td>
<td>Alter any database event notification</td>
</tr>
<tr>
<td></td>
<td>Alter any dataspace</td>
</tr>
<tr>
<td></td>
<td>Alter any fulltext catalog</td>
</tr>
<tr>
<td></td>
<td>Alter any message type</td>
</tr>
<tr>
<td></td>
<td>Alter any remote service binding</td>
</tr>
<tr>
<td></td>
<td>Alter any role</td>
</tr>
<tr>
<td></td>
<td>Alter any route</td>
</tr>
<tr>
<td></td>
<td>Alter any service</td>
</tr>
<tr>
<td>Grant List</td>
<td>Deny List</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Alter any symmetric key</td>
<td></td>
</tr>
<tr>
<td>Alter any user</td>
<td></td>
</tr>
<tr>
<td>Checkpoint</td>
<td></td>
</tr>
<tr>
<td>Create aggregate</td>
<td></td>
</tr>
<tr>
<td>Create assembly</td>
<td></td>
</tr>
<tr>
<td>Create asymmetric key</td>
<td></td>
</tr>
<tr>
<td>Create certificate</td>
<td></td>
</tr>
<tr>
<td>Create contract</td>
<td></td>
</tr>
<tr>
<td>Create database ddl event notification</td>
<td></td>
</tr>
<tr>
<td>Create default</td>
<td></td>
</tr>
<tr>
<td>Create fulltext catalog</td>
<td></td>
</tr>
<tr>
<td>Create function</td>
<td></td>
</tr>
<tr>
<td>Create message type</td>
<td></td>
</tr>
<tr>
<td>Create queue</td>
<td></td>
</tr>
<tr>
<td>Create remote service binding</td>
<td></td>
</tr>
<tr>
<td>Create role</td>
<td></td>
</tr>
<tr>
<td>Create route</td>
<td></td>
</tr>
<tr>
<td>Create rule</td>
<td></td>
</tr>
<tr>
<td>Create schema</td>
<td></td>
</tr>
<tr>
<td>Create service</td>
<td></td>
</tr>
<tr>
<td>Create symmetric key</td>
<td></td>
</tr>
<tr>
<td>Create type</td>
<td></td>
</tr>
<tr>
<td>Create view</td>
<td></td>
</tr>
<tr>
<td>Subscribe query notifications</td>
<td></td>
</tr>
<tr>
<td>Take ownership</td>
<td></td>
</tr>
</tbody>
</table>
5. Search for the ODS database, and set the same permissions as for the Tenant database. Repeat Step 2 on page 39 to Step 4 on page 39 for the ODS database.

6. If you have created the database automatically, the SAS Marketing Operations Management database user belongs to the db_owner role. You need to remove the user from the db_owner role. Verify whether the SAS Marketing Operations Management database user is listed under Databases ⇒ Database ⇒ Security ⇒ Users.
   - If the SAS Marketing Operations Management database user is not listed, then verify whether the dbo login user account corresponds to the SAS Marketing Operations Management database user account. Double-click on the dbo user and verify whether the login name is the same as the SAS Marketing Operations Management database user login account. If they are the same, then set the database owner to the sa account by right-clicking the database, select Properties, and then click the Files link in the left pane.
   - If the SAS Marketing Operations Management database user is listed, then double-click on the SAS Marketing Operations Management database user. Remove the user from the db_owner role by clearing the check box (in the Database role membership section), and then click OK.

7. If the SAS Marketing Operations Management database user is not listed under Databases ⇒ Database ⇒ Security ⇒ Users, then create a SAS Marketing Operations Management database user corresponding to the user login account that you created for the database server. Right-click Users and select New User. Provide the SAS Marketing Operations Management database user name for the User name and select the SAS Marketing Operations Management database user login account for the login name.

8. Go to Databases ⇒ Database ⇒ Security ⇒ Users. Double-click on the user name, and select the SASMOM Role role under the Database role membership section in the right pane.

9. If the user is a member of the dbcreator role, remove the SAS Marketing Operations Management database user login account from that role. To do so, go to Server ⇒ Security ⇒ Logins, double-click on the user name, and click the Server Roles link in the left pane.

Note:
   - Before you create a new tenant, add the SAS Marketing Operations Management database user login account back in the dbcreator role.
   - Similarly, before you perform a migration or update of SAS Marketing Operations Management, you must add the SAS Marketing Operations Management database user back into the dbowner role, and remove it from <SASMOM Role> role.

Disable HTTP

If you selected the HTTPS protocol while you were installing SAS Marketing Operations Management, you must disable HTTP.

To disable HTTP:
1. Select Start ⇒ Run and type IIS Manager.
2. Click the Default Web Site node in the tree view in the left pane.
3. Double-click the SSL Settings icon.
4. Select the **Require SSL** check box.
5. Select the **Ignore** radio button for the Client certificates.

**Configure FTP Sites for the Artwork Producer**

If you are using Artwork Producer, then you need to create the following FTP sites:

<table>
<thead>
<tr>
<th>FTP Site Name</th>
<th>Folder Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExportedFormats or &lt;TenantName&gt;_ExportedFormats</td>
<td>\Installation Folder \TenantName\Exported Formats</td>
<td>Formats exported from the system are copied into this folder. You can use this FTP site to download the exported format.</td>
</tr>
<tr>
<td>DownloadedFormats or &lt;TenantName&gt;_Downloaded Formats</td>
<td>\Installation Folder \TenantName\Downloaded Formats</td>
<td>Formats downloaded from the system are copied into this folder. You can use this FTP site to download the format.</td>
</tr>
<tr>
<td>&lt;Any Name&gt;</td>
<td>\Installation Folder \TenantName\Import Formats</td>
<td>The system uses this folder to pick up formats to be exported out of the system. You can upload exported formats (to be imported into the system) to the folder by using this FTP site.</td>
</tr>
</tbody>
</table>

After you create these FTP sites, you must modify the `<TenantName>.xml` file that is located in `<InstallationDir>\Configuration\XML` on the solutions machine. Make the following changes in this file:
1. Go to the `ARTWORKPRODUCER\EXPORTFORMAT\FTPNAME` node and modify the FTP name to be the name that was supplied when ExportedFormats was created.

2. Go to the `ARTWORKPRODUCER\DOWNLOADFORMAT\FTPNAME` node and modify the FTP name to be the name that was supplied when ExportedFormats was created.

**Restart the Windows Services**

After you create the Cataloger Mount Point, restart the following Windows services:

- SAS MOM Back-Office Service
- SAS MOM Cataloger Service
- SAS MOM DAM Job Copy Service (only if this service is installed)
- SAS MOM Dashboard Service
- SAS MOM File Watcher Service
- SAS MOM Format Watcher
- SAS MOM Notification Service
- SAS MOM PluginService Service
- SAS MOM Queue Manager Service
- SAS MOM Replication Agent Service (only if this service is installed)
- SAS MOM Report Scheduler
- SAS MOM Service Monitor
- SAS MOM Text Cataloger Service
- SAS MOM NTFS Monitoring Service

Refer to “Running a Service under the MOMUSR Context” on page 72 for more information.

**Verify Scheduled Tasks**

The following scheduled tasks are created automatically:

- AL_DAMBackGroundRequestHandler
- ALCleanUp utility
- DAMVaultUserAccessUpdate
- MOMDiagnosticUtilityRptGenerator
- SecurityPolicyUpdate

If these tasks are not scheduled, determine whether the scheduled tasks have been created. Refer to “Configuring Scheduled Tasks” on page 91 for more information.
# Chapter 6
## Additional Configuration Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the MOMUSR Password</td>
<td>46</td>
</tr>
<tr>
<td>Change the MOMUSR Password on the Servers</td>
<td>46</td>
</tr>
<tr>
<td>Change the Password on Windows Services</td>
<td>46</td>
</tr>
<tr>
<td>Change the MOMUSR Password in the DCOM Configuration</td>
<td>46</td>
</tr>
<tr>
<td>Change the MOMUSR Password for Application Pools</td>
<td>47</td>
</tr>
<tr>
<td>Verify the System</td>
<td>47</td>
</tr>
<tr>
<td>Configuring the Media Server Proxy</td>
<td>47</td>
</tr>
<tr>
<td>Configuring the Replication Agent</td>
<td>48</td>
</tr>
<tr>
<td>Configure the Replication Agent</td>
<td>48</td>
</tr>
<tr>
<td>Configure the Replication Server</td>
<td>49</td>
</tr>
<tr>
<td>Routing Media Requests</td>
<td>50</td>
</tr>
<tr>
<td>Installing Replication Agent Services</td>
<td>51</td>
</tr>
<tr>
<td>Fine-Tuning Tips</td>
<td>51</td>
</tr>
<tr>
<td>Running Services Selectively</td>
<td>51</td>
</tr>
<tr>
<td>Improving the Performance of the Digital Asset Manager Module</td>
<td>52</td>
</tr>
<tr>
<td>Improving the Performance Of SAS Marketing Operations Management</td>
<td>52</td>
</tr>
<tr>
<td>Tuning the Database</td>
<td>54</td>
</tr>
<tr>
<td>IIS Performance Tuning</td>
<td>55</td>
</tr>
<tr>
<td>Minimize Logging</td>
<td>55</td>
</tr>
<tr>
<td>Application Pool Settings</td>
<td>55</td>
</tr>
<tr>
<td>Configure SAS Marketing Operations Management for Full Text Searching</td>
<td>56</td>
</tr>
<tr>
<td>Suppress Dialog Boxes for Automatic Updates</td>
<td>56</td>
</tr>
<tr>
<td>SAS Marketing Operations Management Diagnostic Utility</td>
<td>57</td>
</tr>
<tr>
<td>Configure SAS Marketing Operations Management Cleanup Utility</td>
<td>59</td>
</tr>
<tr>
<td>SAS Marketing Operations Management Service Monitor Configuration</td>
<td>61</td>
</tr>
</tbody>
</table>
Changing the MOMUSR Password

_change the momusr password on the servers_

The MOMUSR is created at the time of installation. Depending on the password policies at your organization, you need to change the password periodically. If the MOMUSR is selected as a local system user, then you must complete the following steps.

_note:_ The password for MOMUSR should be the same on all servers in your configuration.

To change the password on all the servers in your configuration:
1. Select **Start** ⇒ **Control Panel**. Click **Administrative Tools**.
2. In the tree view, expand **Local Users and Groups** under **Computer Management**.
3. Right-click **MOMUSR** and select **Set Password**.
4. Enter the new password, and click **OK**.

_change the password on windows services_

You must modify the Windows services related to SAS Marketing Operations Management, which run on the MOMUSR account.

Complete the following steps for each SAS Marketing Operations Management service that is in your configuration:

_note:_ You must complete these steps on all the servers that are in your configuration.

1. Open the Services applet.
2. Right-click on a service, and select **Properties**.
3. Click the **Log On** tab. MOMUSR is the default account.
4. Modify the password.
5. Click **Apply** to apply the settings. Click **OK**.
6. Restart the service.

_change the momusr password in the dcom configuration_

You need to change the DCOM configuration for Microsoft Office applications, depending on which of the following applications are installed in your environment:

- Microsoft Excel
- Microsoft Office Word
- Microsoft Office PowerPoint

To change the password for MOMUSR in the DCOM configuration:
1. Select **Start** ⇒ **Run**, and then open DCOMCnfg.
2. Select **Component Services** ⇒ **Computers** ⇒ **My Computer** ⇒ **DCOM Config**.
3. Right-click on the application and select **Properties**. On the **Identity** tab, change the settings. MOMUSR is selected.

4. Modify the password.

5. Click **Apply** to apply the settings.

6. Click **OK** to save and close the configuration.

---

**Change the MOMUSR Password for Application Pools**

Complete the following steps to change the MOMUSR password for SASMOMAppPool.

*Note:* You need to follow the steps on solutions, web services, cataloger, media server, and Microsoft Office processor servers.

To change the MOMUSR password for the SASMOMAppPool:

1. Open Internet Information Services (IIS) Manager from the **Start** menu. Navigate to the path `<Server Name>\Application Pools`.

2. Click the **Advanced Settings** option for SASMOMAppPool.

3. Expand the Process Model section. Click the ellipsis button in the **Identity** row.

4. Click **Custom account**, and then click **Set**.

5. Modify the password and click **OK**.

---

**Verify the System**

After you complete all the changes for the MOMUSR password, complete the following tasks:

- Verify that the Windows services are started on all the servers.
- Verify that a login to the SAS Marketing Operations Management system via a browser is successful.
- Test the specific modules.

---

**Configuring the Media Server Proxy**

SAS Marketing Operations Management uses the Media Server component to share the load of the IIS for downloading data from the system. When you are downloading files, SAS Marketing Operations Management directly accesses the Media Server. If you have a DMZ setup and the media server is installed on an internal server, then SAS Marketing Operations Management cannot access the Media server directly. To handle this situation, use the following workaround:

When you are installing solutions in DMZ, select **Media Server** along with the other components. This Media Server will be treated as a proxy of the internal Media Server. You must change the following configuration after the installation.

Tenant Web.config on the external solution machine:

```xml
<add key="DeploymentMode" value="MULTI" />
```
Media services web.config on the external solution machine. Add the following keys:

```xml
<add key="ALMEDIASERVERFILEDOWNLOADURL" value="http://<External solution machineIP>/ALMediaServices/Aspx/FileDownload.aspx" />
<add key="ALMEDIASERVERMTOMWS" value="http://<Media ServerIP>/ALMediaServices/ALMTOMWS.asmx"/>
<add key="ISMEDIASERVERPROXYINSTALLED" value="true"/>
<add key="UploadAssemblyName" value="<Installation Dir>\SAS MOM\<Tenant Folder>\Bin\ALCommonExtension.dll"/>
```

Dashboard service exe configuration on the internal server, InstallationMode = MULTI.

After completing these changes, the external solution can download the original and preview files from the system, and display the digital asset channels on the external server.

---

## Configuring the Replication Agent

The following sections provide the guidelines for installing the Replication Agent, which is used to replicate files across machines. You must complete the following configurations before you start the agent.

### Configure the Replication Agent

The Replication Agent is always installed on the Solutions (web server) machine. The Replication Configuration XML file is present in `<Installation Directory>\Configuration\ReplicationAgentConfig.xml`.

**Note:** Replication does not replicate sites across machines. You must manually replicate sites that are created in the system through an internal or external setup onto other machines. Sites that are created on the internal setup have to be copied manually on the external machine. This holds true for external to internal also. Whenever any changes are made to a site, you should complete the replication process.

To configure the Replication Agent:

1. Replace `$AL$INSTALLDIR$AL$` with installation directory path. For example, replace `$AL$INSTALLDIR$AL$` with `D:\SASMOM60_R14`.
   **Note:** Do not include a backslash at the end of the path.

2. Replace `$AL$TENANTNAME$AL$` with the name of the created tenant. For example, replace `$AL$TENANTNAME$AL$` with ASO.

3. FILESTOPRESERVE: This has to be configured only when certain attributes from the file need to be retained after replication.

   **Note:** If attributes do not need to be retained after replication, remove the FILESTOPRESERVE node.

The following folders and files are monitored by the Replication Agent Service:
### Table 6.1 Folders and Files Monitored by the Replication Agent Service

<table>
<thead>
<tr>
<th>Folder</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\DAM\Configuration\XML</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\DAM\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\MediaLibrary\Configuration\XML</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\MediaLibrary\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\StrategicPlanner\Configuration\XML</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\StrategicPlanner\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\MarketingWorkbench\Configuration\XML</code></td>
<td><code>SolutionConfiguration.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\MarketingWorkbench\Configuration\XML</code></td>
<td><code>_DataTransferConfig.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\MarketingWorkbench\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\Approvals\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\Approvals\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\Administration\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\Administration\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\ResourceManagement\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\ResourceManagement\Configuration\XML\FormBuilder</code></td>
<td><code>*.xml</code></td>
</tr>
</tbody>
</table>

**Configure the Replication Server**

The Replication Server is always installed on the SAS Marketing Operations Management Services machine.
On that machine, configure the ReplicationServerConfig.xml file that is located in the `<installation-directory>\Configuration\XML` folder. You must change the following configuration to indicate the agents that are present and the details about that agent.

```xml
<CONFIGURATION>
  <AGENTLIST>
    <INTERNALAGENT>
      <AGENT IP="198.113.120.127">c:\SAS MOM 60</AGENT>
    </INTERNALAGENT>
    <EXTERNALAGENT>
      <AGENT IP="198.113.120.172">E:\SAS MOM 60</AGENT>
    </EXTERNALAGENT>
  </AGENTLIST>
</CONFIGURATION>
```

After you change the configuration, the XML file contains information similar to the following:

```xml
<CONFIGURATION>
  <AGENTLIST>
    <INTERNALAGENT>
      <AGENT IP="198.113.120.127">c:\SAS MOM 60</AGENT>
    </INTERNALAGENT>
    <EXTERNALAGENT>
      <AGENT IP="198.113.120.172">E:\SAS MOM 60</AGENT>
    </EXTERNALAGENT>
  </AGENTLIST>
</CONFIGURATION>
```

If the communication protocol for internal agents is always TCP, then the communication protocol for external agents is http:// by default.

### Routing Media Requests

This setting is required only if you are using an external machine (not in network).

Open the file in `<installation-directory>\Configuration\XML\MediaRequestRouter.xml`. You need to change the node that is specific to ReplicationServer in MEDIAPROCESSQ to point to the internal machine ReplicationServerQ. Change the highlighted portion to the following:

```xml
  FormatName:DIRECT=http://<Internal machine IP address>/msmq/Private$/ReplicationServerQ
```

After you make the changes, the XML file contains information that is similar to the following:

```xml
<MEDIAPROCESSOR SOLUTIONNAME="ReplicationManager">
  <ROUTEMESSAGETIMEOUT>720</ROUTEMESSAGETIMEOUT>
  <APPLICATION TYPE="ReplicationServer">
    <MEDIAPROCESSORQPATH>FormatName:DIRECT=http://198.113.120.127/msmq/Private$/ReplicationServerQ</MEDIAPROCESSORQPATH><FILEPATH><REPLACEABLEPATH>D:\SAS MOM\Replication</REPLACEABLEPATH></FILEPATH></APPLICATION>
</MEDIAPROCESSOR>
```

If the communication protocol for internal agents is always TCP, then the communication protocol for external agents is **http://** by default.
Installing Replication Agent Services

After you have completed the configuration, start the services. To install the Replication Agent, run the InstallReplicationAgentServices.bat file from the `<Installation Directory>\Binaries` folder. The service is installed and is displayed in the Services Panel.

Replication also requires the SAS MOM Queue Manager Service to be running. Start both the services from Service Panel.

*Note:* To uninstall the replication service, run the UninstallReplicationAgentServices.bat file from `<installation-directory>\Binaries`. The SAS MOM Replication Agent Service is removed from the Service Panel.

Fine-Tuning Tips

Running Services Selectively

When SAS Marketing Operations Management is installed, several Windows services are also installed. These services run in the background to facilitate certain functionality that is provided by different solutions. As these processes run in the background, they consume resources in terms of database access and memory. You can selectively start these services, depending on whether the service is required.

*Table 6.2  Services and Dependencies*

<table>
<thead>
<tr>
<th>Service Name</th>
<th>Modules that Require this Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS MOM Back-Office Service</td>
<td>Marketing Workbench, Strategic Planner, and so on.</td>
</tr>
<tr>
<td>SAS MOM BusinessEvents Service</td>
<td>Strategic Planner (for Marketing Workbench, Claims Management, Offer Management, and all other modules that track change management – Audit History on forms)</td>
</tr>
<tr>
<td>SAS MOM Cataloger Service</td>
<td>Digital Asset Manager (can also be used by other modules such as Artwork Producer if cataloging is used)</td>
</tr>
<tr>
<td>SAS MOM DAM Job Copy Service</td>
<td>Digital Asset Manager</td>
</tr>
<tr>
<td>SAS MOM Dashboard Service</td>
<td>Dashboard and Calendars</td>
</tr>
<tr>
<td>SAS MOM File Watcher Service</td>
<td>Digital Asset Management (can also be used by other modules such as Artwork Producer if cataloging is used)</td>
</tr>
<tr>
<td>SAS MOM Format Watcher</td>
<td>Artwork Producer</td>
</tr>
<tr>
<td>Service Name</td>
<td>Modules that Require this Service</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAS MOM Notification Service</td>
<td>All modules</td>
</tr>
<tr>
<td>SAS MOM NTFS Monitoring Service</td>
<td>Currently not used by any module but can be configured to track any events on the NTFS.</td>
</tr>
<tr>
<td>SAS MOM PluginService Service</td>
<td>Marketing Workbench, Approvals, Strategic Planner</td>
</tr>
<tr>
<td>SAS MOM Queue Manager Service</td>
<td>Marketing Workbench, Approvals, Reports, Timesheets, Strategic Planner, Digital Asset Manager</td>
</tr>
<tr>
<td>SAS MOM Replication Agent Service</td>
<td>All modules</td>
</tr>
<tr>
<td>SAS MOM Report Scheduler</td>
<td>Reports</td>
</tr>
<tr>
<td>SAS MOM Service Monitor</td>
<td>All modules (this service monitors all the services that are used by various modules)</td>
</tr>
<tr>
<td>SAS MOM Text Cataloger Service</td>
<td>Digital Asset Manager(text search)</td>
</tr>
</tbody>
</table>

**Improving the Performance of the Digital Asset Manager Module**

Here are the keys and their values that need to be added in the Web.config file located at `<installation-folder>/<tenant-name>` on the server on which the modules are installed.

Example values:

```xml
<add key="MULTIDOMAINSUPPORT" value="true" />
<add key="MAXDOMAINCOUNT" value="5" />
<add key="PREFIXDOMAINNAME" value="Sun" />
<add key="SUFFIXDOMAINNAME" value="india.sas.com" />
```

Multi-domain support improves performance while fetching the thumbnails in Digital Asset Manager. The browser serializes the request to download a particular file. If 100 assets are to be shown on the screen, then more time is required to download the files. You can download only two files at a time. If multiple domains are configured, then these requests are divided into the number of domains, which improves performance.

*Note:* Configure the domain before you set the multi-domain key to **True**.

**Improving the Performance Of SAS Marketing Operations Management**

**SQL Services**

In order to improve the performance of SAS Marketing Operations Management, start only the SQL services that the following table indicates should be started.
### Table 6.3  SQL Services

<table>
<thead>
<tr>
<th>SQL Service</th>
<th>Started or Not Started</th>
<th>Automatic, Manual, or Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server (MSSQLSERVER)</td>
<td>Started</td>
<td>Automatic</td>
</tr>
<tr>
<td>SQL Server Active Directory Helper</td>
<td>Not Started</td>
<td>Disabled</td>
</tr>
<tr>
<td>SQL Server Agent (MSSQLSERVER)</td>
<td>Started</td>
<td>Automatic</td>
</tr>
<tr>
<td>SQL Server Analysis Services (MSSQLSERVER)</td>
<td>Not Started</td>
<td>Manual</td>
</tr>
<tr>
<td>SQL Server Browser</td>
<td>Not Started</td>
<td>Disabled</td>
</tr>
<tr>
<td>SQL Server FullText Search (MSSQLSERVER)</td>
<td>Started</td>
<td>Automatic</td>
</tr>
<tr>
<td>SQL Server Integration Services</td>
<td>Not Started</td>
<td>Manual</td>
</tr>
<tr>
<td>SQL Server Reporting Services (MSSQLSERVER)</td>
<td>Off</td>
<td>Manual</td>
</tr>
<tr>
<td>SQL Server VSS Writer</td>
<td>Off</td>
<td>Manual</td>
</tr>
</tbody>
</table>

**Cache Management**

Cache management is implemented in SAS Marketing Operations Management for quick retrieval of data rather than searching for information in the database every time. Information such as Entity Type, Facet Type, and Relationship Type are stored in memory. Information such as Named Hierarchies is stored in the file system.

- **Application Service Cache**: The Application Service caches the metadata such as Entity Type, Facet Type, and Relationship Type as an in-memory cache. This type of cache reduces queries to the database. The cache is configurable, and you can turn it on by using the following key in the Web.config file of the ALServices virtual directory: `<add key="OMCacheEnabled" value="true"/>`. The value `true` indicates that the cache is enabled.
  
  *Note*: The cache is refreshed if the metadata is modified from the Schema Designer. If the metadata is modified from somewhere else, then restart the web server on the web services server machine.

- **Named Hierarchy Cache**: SAS Marketing Operations Management caches the Named Hierarchy information as a persistent data on the file system. This improves performance because data is fetched from the cache instead of by web service calls. The cache is stored at the following location: `<installation-folder>\Temp\tenant-name_Cache`

  All the named hierarchies are stored as an XML file.
You can configure the cache and turn it on by using the following key in the Web.config file of the `<tenant-name>` virtual directory on the SAS Marketing Operations Management Solutions machine: `<add key="PersistentCacheEnabled" value="true"/>`. The value `true` indicates that the cache is enabled.

**Note:** If possible, keep this folder out of the cleanup process. The cache is refreshed if the named hierarchy is changed from the Schema Designer. If the named hierarchy is modified from somewhere else, then you must delete the XML files from the persistent cache.

---

## Tuning the Database

To tune the database for better performance:

1. Ensure that there are no active connections to the database:
   - a. Stop all SAS Marketing Operations Management Services on all the servers in the installation.
   - b. Reset IIS on the web services server.
   - c. Run the following script using SQL Server Management Studio. Do not run this script on the ODS database.

   ```sql
   DECLARE @SPID NVARCHAR(5), @CURRENT_SPID SMALLINT, @DBNAME NVARCHAR(75)
   SELECT @CURRENT_SPID = @@SPID
   SELECT @DBNAME = DB_NAME()
   DECLARE C1 CURSOR FOR
   SELECT SP.SPID
   FROM SYS.SYSPROCESSES SP INNER JOIN SYS.DATABASES DB
   ON SP.DBID = DB.DATABASE_ID AND DB.NAME = @DBNAME AND SP.SPID <> (SELECT @@SPID)
   OPEN C1
   FETCH NEXT FROM C1 INTO @SPID
   WHILE @@FETCH_STATUS = 0
   BEGIN
     EXEC ('KILL ' + @SPID)
     FETCH NEXT FROM C1 INTO @SPID
   END
   CLOSE C1
   DEALLOCATE C1

   EXEC (N'ALTER DATABASE ' + @DBNAME + ' SET READ_COMMITTED_SNAPSHOT ON ')
   GO
   ```

   **Note:** Ideally, this script should not take more than 10 seconds to run. If you do not complete all the previous steps in this process, the script runs in an infinite loop. The user running this script must have Alter permission to the database.


2. Temp DB optimization recommendations:
• **Number of data files**: Create one data file per CPU. A dual-core CPU is considered to be two CPUs. Click **Files** and enter the following information:
  
  • **Initial Size**: 500 Mb
  
  • **Autogrowth (File growth)**: 50 Mb
  
  • **Path (Location)**: You should add the Tempdb database on disks that differ from those that are used by user databases.

  *Note*: For more information about these recommendations, see https://msdn.microsoft.com/en-in/library/ms175527(v=sql.105).aspx.

---

**IIS Performance Tuning**

**Minimize Logging**

Microsoft recommends IIS logging to be minimized or even disabled completely on the production servers to improve IIS performance.

For more information about how to disable IIS logging, see the information about logging at https://msdn.microsoft.com/en-us/library/ee377050(BTS.10).aspx.

**Application Pool Settings**

SAS Marketing Operations Management is based on Microsoft .NET technology. It uses various Microsoft technologies in its own solution. These instructions assume that SAS Marketing Operations Management is installed on a Windows 2008 R2 SP1 Server and that IIS 7.5 or Windows Server 2012 R2 and IIS 8.5 is the base platform is the base platform. ASP.NET is disabled by default in IIS 7.5 or IIS 8.5. If you do not enable ASP.NET, an error might be generated. For optimal performance of SAS Marketing Operations Management, enable ASP.NET on Internet Information Services (IIS):

1. Open Internet Information Services Manager.
2. Click **ISAPI and CGI Restrictions**.
3. Right-click **ASP.NET v4.0.30319** and select **Allow**.

To configure the SASMOMAppPool application pool (or any other application pool) using the recommended settings:

1. Disable the **Recycle Worker Process** setting. This setting restarts the ASP.NET worker process after 1740 minutes (that is, 29 hours). To disable this setting:
   
   a. Open the Internet Information Services Manager.
   
   b. Go to **Application Pools / SASMOMAppPool**. Right-click **SASMOMAppPool** and select **Recycling**.
   
   c. In the Recycling Conditions window, ensure that none of the check boxes are selected, and click **Next**.
   
   d. In the Recycling Events to Log window, make sure none of the check boxes are checked and click **Finish**.
2. Disable the **Idle Timeout Shutdown Worker Process** setting. This setting shuts down the ASP.NET worker process if the worker process is idle for 20 minutes. To disable this setting:
   a. Open the Internet Information Services Manager.
   b. Go to **Application Pools /SASMOMAppPool**. Right-click **SASMOMAppPool** and select **Advanced Settings**.
   c. In the Advanced Settings window, ensure that the **Idle Time-out (minutes)** is set to 0.

---

**Configure SAS Marketing Operations Management for Full Text Searching**

The default logical operator that is used for a simple search based on multiple words is **AND**. You can configure the default logical operator.

To change the logical operator to **OR**:
1. Open the **TenantName.xml** file from `<installation-folder>\Configuration\XML`.
2. Look for the following XML node.
   ```xml
   <FULLTEXTSEARCH>
   <LOGICALOPERATOR>AND</LOGICALOPERATOR>
   </FULLTEXTSEARCH>
   ```
3. Change the **AND** to **OR**.
   ```xml
   <FULLTEXTSEARCH>
   <LOGICALOPERATOR>OR</LOGICALOPERATOR>
   </FULLTEXTSEARCH>
   ```

---

**Suppress Dialog Boxes for Automatic Updates**

To disable the automatic updates in Adobe Acrobat X and XI:
1. Select **Help ⇒ Check for Updates**. The Preferences link appears after updates are checked.
2. Click the **Preferences** link. The **Automatically check for updates** check box is displayed.
3. Clear the **Automatically check for updates** check box, and click **OK**.
Beginning with SAS Marketing Operations Management 6.0 R14 Update 2, no files in the file system are physically deleted from the system. This prevents files from being accidentally deleted or lost. When a file is updated or overwritten, either in the user interface or by the system, a *Marked for deletion* flag is appended to the file. Since the files are not explicitly deleted, these files are present in the file system. These files must be cleaned up by a services person or by an administrative user with sufficient product knowledge.

Use the following utilities to clean the system:

1. MOMDiagnosticUtilityRptGenerator: The EXE file for the utility is available at `<installation-folder>\Binaries`. This utility generates an XML report containing a list of files that are marked for deletion and that need to be removed from the server. This utility is executed by a scheduled task (MOMDiagnosticUtilityRptGenerator task) that is created on the application server after installation. This scheduled task runs at 12 a.m. every night and generates one report per tenant. The report is generated at `Installation Directory\Logs \MOMDiagnosticUtility` on the application server.

Read the report in the following manner:

- The utility creates multiple reports in an XML format in batches of 10,000 file entries. For example, if a total of 100,000 entries are found for MARKEDASDELETED, ORPHAN, or MISSING files, then the utility generates 10 reports of 10,000 entries each.
- The report naming convention is MDURG_<Tenant Name>_<_Date Time>_<_Sequence Number>.xml. The sequence number begins at 0. In the previous example, the reports are created from 0 to 9.
- The last file contains the summary information about the space consumed and the file count. The following table describes the summary information:

**Table 6.4 Summary Information Generated by the MOMDiagnosticUtilityRptGenerator Utility**

<table>
<thead>
<tr>
<th>Node in Log File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APP_SERVER_FILES</td>
<td>List of files on the application server that are to be cleaned up.</td>
</tr>
<tr>
<td>MEDIA_SERVER_FILES</td>
<td>List of files on the media server that are to be cleaned up.</td>
</tr>
<tr>
<td>MARKASDELETEDFILES</td>
<td>List of files on all servers that are marked for deletion.</td>
</tr>
<tr>
<td>MARKASDELETEDFILES (with MISSING attribute set to 1)</td>
<td>List of files that are missing. An entry for the file is in the ALFS_FILE table but there is no corresponding physical file on the NTFS.</td>
</tr>
</tbody>
</table>
2. **MOMDiagnosticUtilityRptProcessor**: Run this utility manually. This utility uses the reports generated by the MOMDiagnosticUtilityRptGenerator utility. It cleans the files in the file system and the database entries. It is located in the `<installation-folder>\Binaries folder` directory. This utility performs the cleanup per tenant, and then it generates the log files per tenant.

Read the report in the following manner:

- The utility creates multiple reports in an XML format that correspond to the reports generated by the MOMDiagnosticUtilityRptGenerator utility.
- The report naming convention is `MDURP_<Tenant Name>_<Date Time>_<Sequence Number>.xml`. The sequence number begins at 0. In the previous example, the reports are created from 0 to 9.
- The last file contains the summary information about the space recovered and the file count. The following table describes the summary information:

<table>
<thead>
<tr>
<th>Node in Log File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPACE_CONSUMED</td>
<td>Space consumed (in bytes) by the files marked for deletion on every server. Space is calculated per drive. A combined total of space consumed on all drives is also provided.</td>
</tr>
<tr>
<td>FILE_COUNTS</td>
<td>Count of the files to be cleaned up on every server.</td>
</tr>
<tr>
<td>APP_SERVER_CLEANUP</td>
<td>List of files on the application server that were cleaned up.</td>
</tr>
<tr>
<td>MEDIA_SERVER_CLEANUP</td>
<td>List of files on the media server that were cleaned up.</td>
</tr>
<tr>
<td>MARKASDELETEDFILES</td>
<td>List of files on all servers that were marked for deletion and were cleaned up.</td>
</tr>
<tr>
<td>MARKASDELETEDFILES (with MISSING attribute set to 1)</td>
<td>List of files that were noted as missing on a server and were cleaned up.</td>
</tr>
<tr>
<td>SPACE_RECOVERED</td>
<td>Space recovered (in bytes) by the files that were cleaned up on every server. Space is calculated per drive. A combined total of space recovered on all drives is also provided.</td>
</tr>
<tr>
<td>FILE_COUNTS</td>
<td>The count of the files that were submitted to the utility for cleanup, per server.</td>
</tr>
</tbody>
</table>
Configure SAS Marketing Operations Management Cleanup Utility

The ALCleanup utility is used to periodically clean the temporary folders and files that are used by the SAS Marketing Operations Management system. A copy of this utility is on all the machines in the installation except for the Media Processor. You need to schedule this utility to run on each of the machines in the setup. It works on a configuration XML that specifies the folder and files to be deleted and the folders to exclude during cleanup.

The configuration XML is located at `<installation-folder>\Configuration\XML\ALCleanup.xml`.

The `TempFolder` node specifies the folder contents that need to be deleted. The attribute `Location` of `TempFolder` specifies the path of the folder. For example, `C:\Temp` is the folder whose contents will be deleted.

The `DeleteOlderThan` attribute specifies how old the files are that you want to delete. The value 2 specifies that files older than 2 days need to be deleted.

The `FileExtList` attribute specifies the type of files that you want to delete. You can specify the extension list, separated by a semicolon (;) if you want to delete only specific type of files. If you want to delete all the files, specify `*.*`.

You can specify to delete multiple folders by using the `TempFolder` node multiple times. You can also specify folders inside the `C:\Temp` that you do not want to delete by adding `AVOIDFOLDERLIST` inside the `TempFolder` node.

```xml
<TempFolder Location="C:\Temp" DeleteOlderThan="2" FileExtList="*.jpg;*.bmp" Comments=""></TempFolder><TempFolder Location="C:\SASMOM\Temp" DeleteOlderThan="2" fileExtList="*.*" Comments=""><AVOIDFOLDERLIST><AVOIDFOLDERLIST>C:\SASMOM\Temp\FileConverter</AVOIDFOLDERLIST><AVOIDFOLDERLIST>C:\SASMOM\Temp</AVOIDFOLDERLIST></TempFolder>
```

The above code specifies not to delete the FileConverter folder or its contents, which is inside `C:\<installation-directory>\Temp`. You can add multiple
AVOIDFOLDER nodes in order to specify multiple folders (under the parent path) that should not be deleted.

The following folders need to be cleaned on all the machines:

Table 6.6  Folders to Delete on All Machines

<table>
<thead>
<tr>
<th>Location</th>
<th>File Extension List</th>
<th>Delete Older Than</th>
<th>Folder Deletion Frequency</th>
<th>Folder Deletion Day</th>
<th>Folder location to be avoided for deletion</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;installation-folder&gt;\Temp</code></td>
<td><code>.*</code></td>
<td>2</td>
<td>DAILY</td>
<td>1</td>
<td><code>&lt;Installation Directory&gt;\Temp\&lt;TenantName&gt;_Cache</code></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\DownloadFiles</code></td>
<td><code>.*</code></td>
<td>12</td>
<td>WEEKLY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\UploadedFiles</code></td>
<td><code>.*</code></td>
<td>5</td>
<td>WEEKLY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>C:\Temp</td>
<td><code>.*</code></td>
<td>2</td>
<td>DAILY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Outbox Path</td>
<td><code>.*</code></td>
<td>2</td>
<td>DAILY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\MediaProcessor\ArtworkCache</code></td>
<td><code>.*</code></td>
<td>7</td>
<td>DAILY</td>
<td>1</td>
<td><code>&lt;Installation Directory&gt;\MediaProcessor\ArtworkCache</code> and <code>&lt;Installation Directory&gt;\MediaProcessor\FormatCache</code></td>
</tr>
<tr>
<td>C:\Temp \Plugins</td>
<td><code>.*</code></td>
<td>As per the setting in the Digital Library</td>
<td>DAILY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\MediaProcessor\ArtworkCache</code></td>
<td><code>.*</code></td>
<td>365</td>
<td>DAILY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>File Extension List</td>
<td>Delete Older Than</td>
<td>Folder Deletion Frequency</td>
<td>Folder Deletion Day</td>
<td>Folder location to be avoided for deletion</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------</td>
<td>-------------------</td>
<td>---------------------------</td>
<td>---------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\Errors</code></td>
<td><code>*.*</code></td>
<td>180</td>
<td>DAILY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\Logs</code></td>
<td><code>*.*</code></td>
<td>180</td>
<td>DAILY</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><code>&lt;installation-folder&gt;\&lt;tenant-name&gt;\Logs</code></td>
<td><code>*.*</code></td>
<td>180</td>
<td>WEEKLY</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

**SAS Marketing Operations Management Service Monitor Configuration**

The SAS Marketing Operations Management services are installed on all the machines on which the software is installed. Depending on which components are installed, the services are installed. If you do not want to watch a specific service, then remove its respective node from the list and restart the monitoring service. The XML file for the SAS MOM Service Monitor service is in `<installation-folder>\Configuration\XML\ALServiceMonitorConfiguration.xml`. 
Chapter 7
Uninstalling SAS Marketing Operations Management

Uninstall SAS Marketing Operations Management

To uninstall a SAS Marketing Operations Management setup:

1. Select **Start** ⇒ **Control Panel** ⇒ **Programs and Features**. Select **SAS MOM version_number release_number**. Right-click and select **Uninstall**.

2. Restart the server after the process is completed.

3. After restarting the server, clean up the following items:
   a. If there are shared folders within the installation folder, unshare the folder, and then delete the installation folder.
   b. Delete any folders that were created for the SAS Marketing Operations Management installation outside the installation folder, such as **FileMountPoint**, **XmlMountPoint**, or **DAM Vault folders**.
   c. Delete the registry values that are located at **HKEY_LOCAL_MACHINE\SOFTWARE\Assetlink** within the registry.
   d. Within the IIS Manager, delete all virtual directories that were created for SAS Marketing Operations Management. These directories are found under **<Machine Name>\Sites\Default Web Site** and include directories such as **ADCataloger**, **ALIntegrationServices**, **ALMediaServices**, **ALServices**, **DashboardImages**, **SASMOMJS**, and all directories that point to the tenant folders. To identify virtual directories that point to a tenant, look for the virtual directory that has the same name as the tenant, or check for the **Physical Path** attribute.
   e. Under the IIS Manager remove **SASMOMAppPool**, within the Application Pools section.
   f. In the Computer Management section, look for local user **MOMUSR** and delete it.
   g. If the SAS Deployment Wizard entry for the installation is not removed when you complete the uninstallation process, complete the following steps:
      i. Open the **depleymentreg** folder, which is below the **SASHOME** folder. Open the file registry.xml.
ii. Remove the mominstall key and all the keys directly below it. Save the file.

4. On the database machine, delete all databases that point to the tenants, the ODS database, and all the associated server-level logins.
Chapter 8
Troubleshooting

User Creation Fails—Configure Windows User on the Server .................. 68
Orphan Files Created under File Mount Point .................................. 68
Configure Environment Variables-Failed ......................................... 69
  Configure Environment Variables for All Machines ....................... 69
Virtual Folder aspnet_client Creation Failed ................................. 70
No Security Permissions Exist ..................................................... 70
  On ASP.NET Temporary Files .................................................... 70
  Registry Access ................................................................. 71
  Grant Folder Permissions ....................................................... 71
Adding a DLL in the Global Assembly Cache ................................. 71
Running a Service under the MOMUSR Context .............................. 72
Setting the Event Log ............................................................ 73
Create Shared Drive .............................................................. 74
Database Creation Fails .......................................................... 74
  Create Database for Tenant .................................................... 75
  Run the Database Scripts ...................................................... 75
Create an ODS Database for the Tenant ....................................... 76
Creating Queues Manually ........................................................ 77
Deleting a Tenant ................................................................. 78
  Gather Prerequisite Information ............................................... 78
  Delete a Tenant ................................................................... 82
Configure a Virtual Directory for the Tenant ................................. 86
  Configure the Virtual Directory ................................................. 86
  Create a Virtual Directory for Dashboard .................................... 88
Creating the Desktop Folder ........................................................ 88
Working with Application Pools in IIS Manager .............................. 88
  Create Application Pools ........................................................ 88
  Configure Applications in the Application Pool ........................... 90
Verify Complete Access for MOMUSR ........................................ 91
Configuring Scheduled Tasks ...................................................... 91
  Schedule the Utility ............................................................... 91
  Schedule Task for Digital Asset Manager ................................... 92
User Creation Fails—Configure Windows User on the Server

Note: If MOMUSR already exists on the machine, then the password is reset to what the user entered while installing SAS Marketing Operations Management.

Create MOMUSR on all the machines on which SAS Marketing Operations Management is installed and on the machine on which the shared network folder is created (for supporting a shared network folder). MOMUSR should belong to the Administrators group.

To create the MOMUSR:

1. Go to Start → Administrative Tool → Server Manager → Configuration → Local Users and Groups → Users.
2. Right-click Users and select New User from the speed menu.
3. Enter all the necessary values such as name (MOMUSR) and password.
4. Select User cannot change password.
5. Select Password never expires.
6. Click Create.

Note: Make sure that the user name and password is the same on all the machines in the configuration.

Orphan Files Created under File Mount Point

Orphan files are created in the following cases:

• The files were accidentally copied and pasted on the Application server and Media server under the file mount point or vaults.

• A multi-machine configuration with the Media server enabled was converted to a single-machine configuration with the Media server disabled. Since the Media server is disabled, you must make changes in the Configuration XML, web.config along with database changes.

Update the following three tables in order to disable the Media server for a tenant:

• ALFS_FILE
• ALFS_FOLDER
• ALENT_VAULT

If you do not update these tables, then orphan files might be generated.
Configure Environment Variables-Failed

If the installer fails to configure the environment variables, then follow the steps given below.

Configure Environment Variables for All Machines

The same settings need to be specified on all the machines that are involved in the setup.

Right-click the Computer icon, click Properties, and then click Advanced System Settings. Click the Advanced tab. Click Environment Variables. Set the system environment variables TEMP and TMP to point to folder C: \Temp. Create the folder C: \Temp if it does not exist. Allow Everyone and MOMUSR full control on this folder.

Figure 8.1 System Properties
Virtual Folder aspnet_client Creation Failed

Create a virtual folder named aspnet_client. Point to the aspnet_client folder under www root (for example, C:\Inetpub\wwwroot\aspnet_client).

No Security Permissions Exist

If the security permissions are not provided during the installation process, complete the tasks in the following sections.

On ASP.NET Temporary Files

The folder C:\Windows\Microsoft.NET\Framework64\v4.0.30319\Temporary ASP.NET Files should have Full Control to the Users groups (right-click on this folder and open the Security tabs).
Registry Access

For MOMUSR: This setting needs to be specified on all the machines on which SAS Marketing Operations Management is installed.

To give registry access to the newly created user (MOMUSR):

1. Open the registry by entering `regedit` in the Run window.
2. Navigate to the path `HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\Eventlog`.
3. Right-click and click on the permissions. Add the newly created user (MOMUSR) and give the user full control.

For NETWORK SERVICE users: This setting needs to be specified on all the machines on which SAS Marketing Operations Management is installed.

To give registry access to network services users:

1. Open the registry by entering `regedit` in the Run window.
2. Navigate to the path `HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\Eventlog`.
3. Right-click and click on the permissions. Add the network services users and give them full control.

Grant Folder Permissions

In Windows Explorer:

1. Remove all the inherited permissions for the `Installation Path` folder.
2. Allow the IUSR, NETWORK SERVICE, MOMUSR, and Administrators group accounts full access to the `Installation Path` folder, and provide Read access to the users group on all the machines on which SAS Marketing Operations Management is installed.
3. Right-click on the installation folder and select Properties.
4. Click the Security tab.
5. Select the user and give Full control.

For example, if the server on which the solution is installed is called Metis, the accounts IUSR and NETWORK SERVICE users should be granted full access to the `Installation Path` folder.

Adding a DLL in the Global Assembly Cache

In a multi-machine installation, both the DLLs (FluorineFx.dll and itextsharp.dll) are not required for every component, but the installer tries to install both. Because only the DLL that is required on a particular machine is available, the installer writes a fatal error to the log file if one of the DLLs is not found.

You can ignore this error message under certain conditions:
FluorineFx.dll is required if the following components are installed on a machine:

- Cataloger
- Solutions

itextsharp.dll is required if the following components are installed on a machine:

- Cataloger
- WebServices
- MediaProcessor for InDesign
- Solutions
- MediaServer
- MediaProcessor for FLV Generator

If a DLL is required and it is not installed on the global assembly cache (GAC), complete the following steps to put the files into the assembly:

- If Microsoft Visual Studio is installed on the machine:
  1. Enter the following command at the VS command prompt for Microsoft Visual Studio: `Sn -Vr Dll Path`. For example: `Sn -Vr C:\GACDemo\fluorinefx.dll`.
  2. Enter the following command at the VS command prompt for Microsoft Visual Studio: `Gacutil -i Dll Path`. For example: `Gacutil -i C:\GACDemo\fluorinefx.dll`.

- If you are working in Windows 7 or Windows Server 2008 R2 (64-bit SP1), drag the DLLs to the assembly folder (`C:\Windows\assembly`).

- If you are working in Windows Server 2012 R2, you can use the following PowerShell script on Windows Server 2012 R2 to install the DLL to GAC. The following example code adds FlourineFx to the GAC:

```powershell
[System.Reflection.Assembly]::Load(*System.EnterpriseServices,Version=4.0.0.0,Culture=neutral,PublicKeyToken=b03f5f7f11d50a3a*)
$publish.GacInstall("C:\SASMOMTools\Fluorinefx.dll")
```

Running a Service under the MOMUSR Context

The following services need to run under MOMUSR: SAS MOM Queue Manager, Cataloger, BusinessEvents, PluginService, File Watcher, and Service Monitor. If the installer fails to run these services under MOMUSR, complete the following steps on each of these services in the Services applet:

1. Go to the Services panel by selecting **Start ➔ Administrative Tools ➔ Server Manager**, and then click **Services**.
2. Right-click on the service and select **Properties**.
3. Click the **Log On** tab.
4. Select the **This account** option.
5. Click **Browse** and select the **MOMUSR** account.
6. Click the General tab.
7. Select the start-up type as Automatic.
8. Click OK to apply the settings.

Note: On both the machines, MOMUSR needs to be given full control to the installation folder.

---

**Setting the Event Log**

When the SAS MOM Queue Manager Service is started on any machine, it creates a SAS MOM event log on the event viewer. You should edit a property of this event log so that the event log is never full.

To change the event log setting in the Event Viewer:

1. Start all the services on all the machines in your configuration.
2. Select Start ⇒ Administrative Tools ⇒ Diagnostics and click Event Viewer.
3. In the left pane, right-click the SAS MOM log and select Properties.
4. Select Overwrite events as needed.
A MediaProcessor folder is created on the web services and Media Server machines after SAS Marketing Operations Management is installed. It is created under the installation folder. On both the machines, share the folder, add MOMUSR on the Security tab and the Sharing tab, and specify Full Control to the user.

*Note:* Make sure the shared folder has the name MediaProcessor on both the machines. Do not change the name.

**Database Creation Fails**

If database creation fails, you must create a separate database for each tenant.
Create Database for Tenant

1. Launch Microsoft SQL Management Studio.
2. Connect to the server by entering the database user credentials.
3. In the left pane, right-click Databases, and then click New Database.
4. In the New Database dialog box, enter the new database name and click OK. The new database is now created.

Figure 8.4  New Database

Run the Database Scripts

Run the database scripts against the tenant database by connecting to the SQL Server, using the new login that you created in “User Creation Fails—Configure Windows User on the Server” on page 68. The database scripts are under Installation Folder => Database => SQL Server.
Select the database and click File ➔ Open ➔ File and select the scripts from the Installation Folder ➔ Database ➔ SQL Server. Click Open. Click Execute and connect to the SQL Server using the login that you created for the database.

Note: Keep checking the database name to make sure the scripts are run on the selected database.

Run the database scripts in the following sequence:

1. 1_MOM_SQL_Scripts.sql
2. 2_MOM_Init_SQL_Scripts.sql
3. 1_MOM_DB_Insert_Schema_Script.sql

![Database Scripts](image)

Create an ODS Database for the Tenant

After you complete the steps in “Create Database for Tenant” on page 75, you must create another database. The mandatory convention for naming the ODS database is DB Name for the Tenant_ODS.

Execute the following scripts for the ODS database:

1. 1_ODS_DB_Create_Script.sql
2. 2_ODS_DB_Insert_Script.sql
Creating Queues Manually

Queues are created when SAS Marketing Operations Management is installed. If queues were not created, then you can create the queues manually. Run the batch file Createqueues.bat located under <installation-folder>\Binaries.

The following queues are created:

• On the solution or web server machine:
  • MEDIARESPONSEQ
  • UNDELIVEREDQ
  • REPLIACATIONAGENTQ
  • AP_PREVIEWGENERATIONQ
  • WB_SOLUTIONSQ
  • EVENTQ
  • ALCHEMAGEMENTQ

• On the web services machine:
  • EMAILQ
  • MEDIARESPONSEQ
  • UNDELIVEREDQ
  • ALPROCESSMESSAGEQ
  • EVENTQ
  • ALINTERNALPROCESSQ
  • AACTUALSQ
  • REPLIACATIONSERVERQ
  • SIMULTANEOUSCHECKOUTQ
  • SEQUENTIALCHECKOUTQ
  • FILEMETADATAHANDLERQ
  • COPYMOVERQUESTHANDLERQ
  • ALESTIMATEQ
  • IMPORTJOBQ
  • COPYPLANQ
  • SIMULTANEOUSEVENTQ
  • ALCHEMAGEMENTQ

• On the InDesign Machine:
  • INDESIGNCS3Q
  • RESPONSEUNDELIVEREDQ
  • pnq_in
Deleting a Tenant

Gather Prerequisite Information

To gather the information required to delete the tenant:

1. Determine the name of the tenant database and the ODS database for the tenant. Tenant and ODS database names for the tenant are available in the Tenant Name.xml file on the web services server.
   
a. Navigate to Tenant Name.xml in the Installation Folder \Configuration\XML folder.
   
b. In the Tenant Name.xml file, the value of the CONNECTIONSTRING node contains the name of the tenant database. The value of the CONNECTIONSTRINGFORODS node contains the name of the ODS database for the tenant. The values are encrypted. To get the name of the database, the value should be decrypted.
Note: The web page used to decrypt the value is not deployed with SAS Marketing Operations Management. You must request the page from SAS Technical Support.

**Figure 8.6 Tenant XML File**

```
<configuration>
  <database>
    <connectionstring>UEMqSi4HzK=nRiduo2yVvTvIADjKtByGjJ3izpZtmJtrI</connectionstring>
    <connectionstringforodds>APnEikMrjKrjKd=4BoIeiwejprkWR03pGyebbWbp6</connectionstringforodds>
    <connectionstringforodds>APnEikMrjKrjKd=4BoIeiwejprkWR03pGyebbWbp6</connectionstringforodds>
    <retriesleeptime>1000</retriesleeptime>
    <commandtimeout>180</commandtimeout>
  </database>
</configuration>
```

c. After decrypting the values, check for the **Initial Catalog** parameter. The value of this parameter is the database name.

**Figure 8.7 Initial Catalog Parameter**

```
Data Source=172.26.77.68 Initial Catalog=MOM_DB;
```

2. Determine the Cataloger mount point, the secondary mount point, and the external mount point that are configured for the tenant.

   a. Log on to the system in the browser and navigate to the **Settings** link in the left pane under the **Administration** task pane.
   
   b. Locate the mount points in the **Cataloger Settings** section.

**Figure 8.8 Cataloger Settings**

Note:

- The **Secondary MountPoint** is available if SAS Marketing Operations Management is set up with two catalogers.
- If the specified path is a non-UNC path, then the **MountPoint** and **Secondary MountPoint** are on the Primary and Secondary Cataloger servers respectively.
- If the specified path is a non-UNC path, then the **External MountPoint** is on the server on which the SAS Marketing Operations Management DAMJobCopy Service is installed.

3. Determine the network folder path for the tenant.

   a. Log on to the system in the browser and navigate to the **Settings** link in left pane under the **Administration** task pane.
   
   b. Locate the network folder path in the **DAM Settings** section.
4. Determine the Format Watcher mount point, and the Invoice mount point and archive file path for the tenant
   a. Log on to the system in the browser and navigate to the Settings link in the left pane under the Administration task pane.
   b. Locate the Format Watcher Mount Point in the Format Watcher Settings section.

   **Figure 8.10 Format Watcher Settings**

   Note: Format Watcher Mount Point is found on the web server.

5. Locate the Invoice Mount Point and Archive File Path in the Import Invoice Settings section.

   **Figure 8.11 Import Invoice Settings**

   Note: If the specified path is a non-UNC path, then the Invoice Mount Point and the Archive File Path are on the web services server.

6. Determine the mount point and the XML mount point for the tenant.
   a. Navigate to Installation Folder(Configuration/XML on the web services server and open Tenant Name.xml.
   b. In the XML file, check the values for the MOUNTPOINT and XMLMOUNTPOINT nodes. These values are the paths of the mount point and the XML mount point configured for the tenant.
Note: If the specified path is a non-UNC path, then the MountPoint and XML MountPoint are on the web services server.

7. Determine the vaults for the tenant.
   a. Log on to the system in the browser and navigate to the Digital Library link in the left pane under the MOM task pane.
   b. In the Digital Library, click the Vaults link in the left pane under the Administration task pane.
   c. Locate the system vaults and the vault specified for Artwork Producer on the web services server. Locate the name of the vault used for Artwork Producer in the Tenant settings.
Note: If the path specified for a non-system vault is a non-UNC path, then the vaults are on the web services server. If Media Server is configured for the tenant, then the vaults are on the Media Server.

Delete a Tenant

To delete a tenant:

1. Stop all the SAS Marketing Operations Management Windows Services on all the servers used for the deployment. Stop the IIS service on the web server, web services server, and Media Server.

2. Delete the following for each tenant:
   - Cataloger Mount Point, Secondary Cataloger Mount Point, and External Mount Point.
   - Format Watcher Mount Point, Invoice Mount Point, and Archive File Path
   - Network Folder path
   - Mount Point and XML Mount Point
   - Vaults

3. Delete the Tenant Name application from IIS on the web server. Navigate to Start ⇒ Administrative Tools ⇒ Internet Information Services and remove the Tenant Name application.

4. Remove the tenant reference from the Assetlink.xml on the web services server.
   a. Navigate to Installation Folder\Configuration/XML folder and open Assetlink.xml.
   b. Delete the Tenant Name node.

5. Remove the tenant folder from the installation folder on the web server and the web services server.
   a. Navigate to the Installation Folder.
   b. Delete the Tenant Name folder and the Tenant Name file exchange folder.

6. Remove the cache files for the tenant from the application server.
   a. Navigate to the Installation Folder\OMCACHE folder.
   b. Delete all the files that start with the Tenant Name.
7. Remove the databases for the tenant from the Database Server:
   a. Navigate to SQL Server Management Studio.
   b. On the database machine, delete all the databases that point to the tenants, the ODS database, and all the associated server-level logins.

8. Remove the tenant reference from the Framework_Tree.xml file on the web server:
   a. Navigate to Installation Folder\Configuration\XML folder and edit Framework_Tree.xml.
   b. Search for the Tree node that has the tenant name as the value for the text attribute, and delete that node.
9. Remove CreateTenant_Tenant Name.txt from the web server. Navigate to the<installation-folder> folder and delete CreateTenant_<tenant-name>.txt.

10. If SAS Marketing Operations Management and Marketing Automation have been integrated, then remove the <tenant-name>_QuickStart wsdl.dll from the web server:

   a. If SAS Marketing Operations Management and Marketing Automation integration is configured for a tenant and the WSS feature is set to Yes, then navigate to <installation-folder>\Binaries folder and delete <tenant-name>_QuickStart wsdl.dll.

   b. You should remove the security certificate that is installed on the SAS Marketing Operations Management Web Server for this tenant:

      i. Open a command prompt window.

      ii. Type `mmc` and press Enter. To view the certificates in the local machine store, you must be an Administrator.

      iii. On the file menu, click Add/Remove Snap In.

      iv. Click Add.

      v. In the Add Standalone Snap-in dialog box, select Certificates.

      vi. Click Add.

      vii. In the Certificates snap-in dialog box, select Computer account and click Next. You can select My User account or Service account. If you are not an
administrator of the computer, you can manage certificates only for your user account.

viii. In the Select Computer dialog box, click **Finish**.

ix. In the Add Standalone Snap-in dialog box, click **Close**.

x. In the Add/Remove Snap-in dialog box, click **OK**.

xi. In the Console Root window, click **Certificates (Local Computer)** to view the certificate stores for the computer.

xii. In the tree view, expand **Personal ⇒ Certificates**. In the details section, a certificate installed for MOM-MA integration is listed. Select the certificate and delete it.

**Figure 8.19 Certificates**

---

**Note:** In this example, client.test.com is the name of the certificate. The name of your certificate might differ based on the name that was specified when the certificate was installed.

xiii. In the tree view, expand **Trusted People ⇒ Certificates**. In the details section, a certificate installed for MOM-MA Integration is listed. Select the certificate and delete it.

**Figure 8.20 Certificates**

---

**Note:** In this example, client.test.com is the name of the certificate. The name of your certificate might differ based on the name that was specified when the certificate was installed.
Configure a Virtual Directory for the Tenant

The virtual directories are created automatically during installation and tenant creation. If it fails, create a virtual folder named `<Tenant Name>` that points to `Installation Folder\Tenant Name` folder as its physical path. Then configure the virtual folder.

Configure the Virtual Directory

Go to the IIS Manager (select Start ➞ Administrative Tools ➞ Internet Information Services (IIS) Manager). To create virtual directories:

Right-click Default Website and select Add Application. Add a new application by entering the alias (the tenant name), and enter the path `<installation-folder>\<tenant-name>`. Click OK to save the information.

Figure 8.21  Virtual Directory Configuration

To configure a virtual directory for each tenant:

1. Ensure that in the Default Document window, the document default.aspx is present and at the top.

2. Double click the HTTP Response Headers icon. The HTTP Response Headers window appears. Right-click on the screen, and select Set Common Headers. Select Expire Web content and After, and enter the number of days.

   Note: If you have an HTTPS setup for an installation, set the web content expiration to 1 or more days in the IIS for the tenants.
3. To configure new MIME types, double-click the **MIME Types** icon. Click **Add** in the right pane. Add the new MIME types with the following extensions:

**Table 8.1 Extensions**

<table>
<thead>
<tr>
<th>Associated Extension</th>
<th>Content Type (MIME)</th>
</tr>
</thead>
<tbody>
<tr>
<td>.axd</td>
<td>text/plain</td>
</tr>
<tr>
<td>.css</td>
<td>text/css</td>
</tr>
<tr>
<td>.gif</td>
<td>image/gif</td>
</tr>
<tr>
<td>.js</td>
<td>application/x-javascript</td>
</tr>
<tr>
<td>.xpdl</td>
<td>text/plain</td>
</tr>
<tr>
<td>.flv</td>
<td>video/x-flv</td>
</tr>
<tr>
<td>.swz</td>
<td>application/x-swz</td>
</tr>
<tr>
<td>.air</td>
<td>application/vnd.adobe.air-application-installer-package+zip</td>
</tr>
</tbody>
</table>

**Note:** You should clear the browser cache after any new installation.
Create a Virtual Directory for Dashboard

Create a virtual directory named DashboardImages. See “Configure the Virtual Directory” on page 86 for information about creating a virtual directory. Give Read access to the virtual directory. The virtual directory should be created on the Solutions machine (web server).

You must create this virtual folder on the web server machine where SAS Marketing Operations Management solutions are installed. On a single-machine configuration, the DashboardImages virtual directory should point to the OutBox. In a multi-machine configuration, OutBox is created on the Service Machine. On the Solutions machine, you must manually create a DashboardImages folder and point this to the virtual directory of DashboardImages.

Creating the Desktop Folder

Create a Desktop folder (if one has not already been created) at the following location:

\<windows-installation-directory>\System32\config\systemprofile

Working with Application Pools in IIS Manager

Create Application Pools

If the creation of the application pool fails, you must manually create the application pool:

1. Go to Internet Information Services(IIS) Manager.
2. Right-click Application Pools and select Add Application Pool.
3. Enter `SASMOMAppPool` for the name.
5. Select `Classic` for the Managed pipeline mode.
6. Select the newly created SASMOMAppPool and click **Advance Settings** in the right pane.

**Figure 8.25** Application Pools

7. Change the value of **Regular Time Interval (minutes)** to 0.

*Note:* If the creation of SASMOMAppPool also failed during the installation process, you must also manually configure SASMOMAppPool.

**Configure Applications in the Application Pool**

If the configuration of applications for the application pool fails, you must manually configure them.

1. Select the website (each website created by the SAS Marketing Operations Management application) and click **Basic Settings** in the right pane. The Edit Application dialog box appears.

**Figure 8.26** Basic Settings

2. Click **Select** to change the application pool.

The above steps need to be done on the following servers and their respective applications (websites):

- **Solutions**
  - Tenant
  - DashboardImages
  - ALIntegrationServices
  - ALServices
Verify Complete Access for MOMUSR

Verify that MOMUSR has complete access on all private messaging queues (MSMQs). Go to Programs and right-click Computer. Expand Features ➔ Messaging Queues ➔ Private Queues. For all the SAS Marketing Operations Management queues, verify that MOMUSR has complete access by right-clicking on each of the queues and clicking the Security tab.

Configuring Scheduled Tasks

Schedule the Utility

Note: The scheduled tasks are created automatically. Please check to determine whether the scheduled tasks are created.

To schedule the utility:

1. Select Start ➔ Programs ➔ Accessories ➔ System Tools ➔ Task Scheduler.
2. Right-click Task Scheduler (Local) and select Create Task.
3. Click the General tab and enter and name for the task. Select Run whether user is logged on or not.
4. On the Triggers tab, click New and schedule the task by setting the time at which the task needs to run.
5. On the Actions tab, click New. Browse and select the .exe file located in Installation folder\Binaries.
6. The default settings need to be used on the Conditions tab and the Settings tab.

The utility is now scheduled and will automatically run every day at the time that you specified. The following utilities are scheduled using the above process:

- Schedule Task for Digital Library
DAM Vault User Access Report Generation

Schedule Task for Digital Asset Manager

Schedule AL_DAMBackGroundRequestHandler.exe to run at a time when there is little or no activity on the server. This exe is located in Installation Folder \binaries. It has to be added as a scheduled task on the web services machine.

This task should be scheduled to run at a time when the fewest users are logged in to the system. It needs to be run at a time when the system is not due for restart. This operation takes a while to execute, so ensure that there is sufficient time between the start of the task and the restart of the system.

Perform the following three operations:

- **Recycle Bin cleanup**: To empty the recycle bin of content that is marked for permanent deletion.
- **For marking the assets as expired**: To mark assets that have an expiration date that is before the current date.
  
  Note: This task should be scheduled to be run after 12.00 a.m. This operation takes a while to execute.

- **To calculate the total disk space usage by the Vaults**: To calculate the total space used by the vaults in Digital Asset Manager.

To change the application behavior, the following parameters need to be set in the AL_DAMBackGroundRequestHandler.exe.config file:

SENDEMAILFORVAULTDISKSPACE
If the total used disk space percentage for the vault is greater than the configured number, then the notification specifying disk space details for the vault are sent to the System Administrator and the configured users, depending on the value specified for this configuration. By default, the value is true.

NOTIFYIFUSEDDISKSPACEPERCENTAGEGREATERTHAN
Number specifying the percentage allowed for total used disk space. By default the value is 80.

EMAILIDSFORVAULTDISKSPACENOTIFICATION
Comma-separated email IDs of users who should be notified.


To generate data for a Security Policy report, the SecurityPolicyService.exe application needs to be scheduled to run periodically. The default interval is 3 hours. Create a
schedule task for this application. This exe is located in the Installation Folder\binaries folder. It has to be added as a scheduled task on the web services machine.

**Schedule a DAM Vault User Access Report Generation**

This report is used to get information related to user’s access to vaults in the system. It’s an off line report that is used to populate a temporary table in the database, which is used by the report to display data. To generate data for a DAM Vault User Access report, the DAMVaultUserAccess.exe application needs to be scheduled to run periodically. The default interval is 3 hours. Create a schedule task for this application. This exe is located in the Installation Folder\binaries folder. It has to be added as a scheduled task on the web services machine.

---

**Destroy Session with DELETE Method Not Working**

If the Destroy Session with DELETE Method does not work, you should uninstall the WebDAV Publishing feature. On the Solutions Server that hosts the REST API, select Server Manager ⇒ Roles ⇒ Web Server (IIS) ⇒ Role Services ⇒ WebDAV Publishing. If WebDAV Publishing is installed, click Remove Role Services.

---

**Checking Logs for Errors**

After installation, if any errors occur while using the SAS Marketing Operations Management system, you can check the logs at the following locations:

- On the solution machine, the logs are located at installation-folder\Logs and installation-folder\tenant-name\Logs\Exception
- On the web services machine, the logs are located at installation-folder\tenant-name\Logs, installation-folder\Logs, and installation-folder\MediaProcessorLog
- On the Cataloger machine, the logs are located at installation-folder\tenant-name\Logs, installation-folder\Logs, installation-folder\Errors, and installation-folder\MediaProcessorLog
- On the InDesign machine, the logs are located at installation-folder\Logs and installation-folder\MediaProcessorLog
# Index

<table>
<thead>
<tr>
<th>A</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALUser password</td>
<td>improving performance</td>
</tr>
<tr>
<td>application pools 47</td>
<td>Digital Library Solution 52</td>
</tr>
<tr>
<td>DCOM configuration 46</td>
<td>SQL services 52</td>
</tr>
<tr>
<td>application pool settings 55</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>configuring</td>
<td>managing cache</td>
</tr>
<tr>
<td>cleanup utility 59</td>
<td>Application Service cache 53</td>
</tr>
<tr>
<td>Media Server Proxy 47</td>
<td>Named Hierarchy cache 53</td>
</tr>
<tr>
<td>Replication Agent 48</td>
<td>media request 50</td>
</tr>
<tr>
<td>service monitor 61</td>
<td>minimize logging 55</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>database tuning 54</td>
<td>Replication Agent Services</td>
</tr>
<tr>
<td></td>
<td>installing 51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>full text search</td>
<td>Windows services</td>
</tr>
<tr>
<td>configure 56</td>
<td>modify 46</td>
</tr>
</tbody>
</table>
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.